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HP Support 

Online Services: for 24-hour 
access to information over your 
modem, we suggest these 
services:

World Wide Web URL - Printer drivers, updated HP printer software, 
plus product and support information may be obtained from the 
following URLs:
in the U.S. http://www.hp.com
in Europe http://www2.hp.com
Printer drivers may be obtained from the following sites:
in Japan ftp://www.jpn.hp.com/drivers/
in Korea http://www.hp.co.kr
in Taiwan http://www.hp.com.tw
or the local driver website http://www.dds.com.tw

America Online - America Online/Bertelsmann is available in the 
U.S., France, Germany, and U.K. - Printer drivers, updated HP printer 
software, and support documentation to help answer your questions 
about HP products are available. Use Keyword HP to start your tour 
or call 1-800-827-6364 preferred customer # 1118 to subscribe. In 
Europe, call the appropriate number below:
Austria 0222 58 58 485
France ++353 1 704 90 00
Germany 0180 531 31 64
Switzerland 0848 80 10 11
United Kingdom 0800 279 1234

CompuServe - Printer drivers, updated HP printer software, and 
interactive sharing of technical information with other members is 
available on CompuServe’s “HP User’s forums” (GO HP), or call 
1-800-524-3388 and ask for representative #51 to subscribe. 
(CompuServe is also available in the U.K., France, Belgium, 
Switzerland, Germany, and Austria.)

Obtaining software 
utilities, drivers, and 
electronic Information for 
U.S. and Canada:

Phone:
(805) 257-5565

Mail:
Hewlett-Packard Co.
P.O. Box 1754
Greeley, CO 80632
U.S.A.

Fax:
(805) 257-6866

For Asia-Pacific 
countries/regions:

Contact Mentor Media at (65) 740-4477 (Hong Kong, Indonesia, 
Philippines, Malaysia, or Singapore). For Korea, call (82) (2) 
3270-0805 or (82) (2) 3270-0893.

For Australia, New 
Zealand, and India:

For Australia and New Zealand, call (61) (2) 565-6099. 
For India, call (91) (11) 682-6035.

For European English: For U.K., call (44) (142) 986-5511. For Ireland and outside U.K., 
call (44) (142) 986-5511.

HP direct ordering for 
accessories or supplies:

Call 1-800-538-8787 (U.S.) or 1-800-387-3154 (Canada).

HP Support Assistant 
compact disc:

This support tool offers a comprehensive online information system 
designed to provide technical and product information on HP 
products. To subscribe to this quarterly service in the U.S. or Canada, 
call 1-800-457-1762. In Hong Kong, Indonesia, Malaysia, or 
Singapore, call Mentor Media at (65) 740-4477.
EN     iii
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HP Service Information: To locate HP-Authorized Dealers, call 1-800-243-9816 (U.S.) or 
1-800-387-3867 (Canada).

HP Service Agreements: Call 1-800-835-4747 (U.S.) or 1-800-268-1221 (Canada).
Extended Service 1-800-446-0522

HP FIRST: HP FIRST Fax will deliver detailed troubleshooting information on common software and 
troubleshooting tips for your HP product. Call from any touch tone phone and request up to three 
documents per call. These documents will be sent to the fax of your choice.

Australia +61 (0) 3 9272 2627 Korea +82 (0) 02 769 0543

Austria 0660-8218 Malaysia +60 (0) 3 298 2478

Belgium (Dutch) 0800 1 1906 Netherlands 0800-0222420

Belgium (French) 0800 1 7043 New Zealand +64 (0) 09 356 6642

Canada 1-800-333-1917 Norway 800-11319

China +86 (0) 10 6505 5280 Portugal 05 05 313342

Denmark 800-10453 Philippines +65 275 7251

English (outside of U.K.) +31 20 681 5792 Singapore +65 275 7251

Finland 800-13134 Spain 900-993123

France 0800-905900 Sweden 020-79-5743

Germany 0130-810061 Switzerland (German) 0800-551527

Hong Kong 852-2506-2422 Switzerland (French) 0800-551526

Hungary (36) (1) 252-4647 Taiwan (886) (2) 719-5589

India +91 (0) 11 682 6031 Thailand +66 (0) 2 661 3511

Indonesia +62 (0) 21 352 2044 United Kingdom 0800-960271

Italy 1678-59020 United States 1-800-333-1917

Japan +81 (0) 3 3335 8622

HP Support  (continued)
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Customer Support Worldwide

Customer Support and Product 
Repair Assistance for the U.S. and 
Canada:

(Refer to the service and support 
chapter of this user guide for 
additional product repair 
information.)

Call (1) (208) 323-2551 Monday through Friday from 6 
am to 10 pm, Saturday 9 am to 4 pm (Mountain Time) 
free of charge during the warranty period. However, your 
standard long-distance phone charges still apply. Have 
your system nearby and your serial number ready when 
calling. 

If you know your printer needs repair, call 
1-800-243-9816 to locate your nearest HP-Authorized 
service provider, or call 208-223-2551 for HP centralized 
service dispatch.

Post-warranty telephone assistance is available to 
answer your product questions. Call (1) (900) 555-1500 
($2.50* per minute, U.S. only) or call 1-800-999-1148 
($25* per call, Visa or MasterCard, U.S. and Canada) 
Monday through Friday from 7 am to 6 pm and Saturday 
from 9 am to 3 pm (Mountain Time). Charges begin only 
when you connect with a support technician. *Prices 
subject to change.

European Customer Support Center Language and In-Country Options 
Available
Open Monday through Friday 8:30–18:00 CET

HP provides a free telephone support service during the warranty period. By calling a telephone number 
listed below, you will be connected to a responsive team waiting to help you. If you require support after 
your warranty has expired, you can receive support for a fee through the same telephone number. The fee 
is charged on a per-incident basis. When calling HP, have the following information ready: product name 
and serial number, date of purchase, and description of the problem.

English

Dutch

French

Ireland: (353) (1) 662-5525
U.K.: (44) (171) 512-5202
International: (44) (171) 
512-5202
Belgium: (32) (2) 626-8806
Netherlands: (31) (20) 
606-8751
France: (33) (01) 43-62-3434
Belgium: (32) (2) 626-8807
Switzerland: (41) (84) 880-1111

German

Norwegian
Danish
Finnish
Swedish
Italian
Spanish
Portuguese

Germany: (49) (180) 525-8143
Austria: (43) (1) 0660-6386

Norway: (47) 2211-6299
Denmark: (45) 3929-4099
Finland: (358) (9) 0203-47288
Sweden: (46) (8) 619-2170
Italy: (39) (2) 264-10350
Spain: (34) (90) 232-1123
Portugal: (351) (1) 441-7199
EN     v
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In-country/region support numbers:   If you require support after your warranty has expired, 
additional product repair services, or if your country/region is not listed below, see “Worldwide Sales and 
Service Offices.”

Argentina 787-8080 Japan (81) (3) 3335-8333

Australia (61) (3) 272-8000 Malaysia (60) (3) 295-2566

Brazil 022-829-6612 Mexico (Mexico City) 01 800-22147

Canada (1) (208) 323-2551 Mexico (outside 
Mexico City)

01 800-90529

China (86) (10) 65053888-5959 New Zealand (64) (9) 356-6640

Chile 800-360999 Philippines (63) (2) 894-1451

Czech 
Republic

(42) (2) 471-7321 Poland (48) (22) 37-5065

Greece (30) (1) 689-6411 Portugal (351) (1) 301-7330

Hong Kong (852) 800-96-7729 Russia (7) (95) 923-5001

Hungary (36) (1) 343-0310 Singapore (65) 272-5300

India (91) (11) 682-6035 Taiwan (886) (02) 717-0055 

(91) (11) 682-6069 Thailand +66 (0) 2 661-4011

Indonesia (62) (21) 350-3408 Turkey (90) (1) 224-5925

Korea (82) (2) 3270-0700 

Korea outside 
Seoul, call 

(82) (080) 999-0700

Customer Support Worldwide (continued)
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1 Printer Basics

Getting to Know the Printer

This chapter provides information in the following areas:

! Printer Features

! Printer Software

! Control Panel

! Printing with the Infrared Port (Wireless Printing)

! Interface Ports

! Accessories and Ordering Information
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Printer Features 

 

Fast Print 
Speed

! 10 pages-per-minute printing (with Intel 80960JD RISC-based 
formatter).

Excellent Print 
Quality

! True 1200 x 1200 dots per inch (dpi) text and graphics.

! Resolution Enhancement technology (REt) adjusts the size and 
placement of each dot on the page to produce smooth angles, 
curves, and edges (600 dpi only).

! Adjustable settings to optimize print quality. 

! The HP UltraPrecise toner cartridge has a finer toner formulation 
which provides sharper text and graphics

Flexible Paper 
Handling

! Adjustable Tray 1 for letterhead, envelopes, labels, transparencies, 
custom-sized media, postcards, and heavy paper. See “Loading 
Media into Tray 1” on page 31.

! Adjustable Tray 2 or an optional 250-Sheet Input Tray (Tray 3) for 
standard sizes of paper. See “Reloading Media into Tray 2 or 
Optional Tray 3” on page 32.

! Two output bins: select either the top output bin or the rear output 
bin for the most convenient output location.

! Straight-through paper path capability from Tray 1 to the rear output 
bin. 

Expandability ! Optional Tray 3 with a 250-sheet capacity to increase the time 
before it is necessary to add paper.

! Enhanced Input Output (EIO) cards. See “Interface Ports” on page 
22.

! Dual In-line memory module (DIMM) slots for adding memory.
! PostScriptTM Level 2 Emulation (PS) DIMM adds PS printing. 

Factory installed on the 2100 M and 2100 TN.

PCL Printer 
Language and Fonts

! Fast printing performance, built-in Intellifont and TrueType scaling 
technologies, built-in HP-GL/2 vector graphics, and advanced 
imaging capabilities are benefits of the PCL 6 printer language. 
This also includes 45 scalable TrueType fonts and one bitmapped 
Line Printer Font.

PS Language and 
Fonts

! The HP LaserJet 2100 M and 2100 TN printers include the HP PS 
Level 2 printer language emulation with 35 built-in PS language 
fonts.
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Automatic Language 
Switching

! When optional printer languages (such as PS emulation) are 
installed, the printer automatically determines and switches to the 
appropriate language for the print job.

Wireless Infrared 
Printing

! Fast infrared (IR) printing when printing from an IrDA-compliant 
device, such as a laptop, notebook computer, or a Personal Digital 
Assistant (PDA).

! JetSend IR enabled devices can also use the IR port.

Interface Connections ! Bidirectional ECP type-B parallel port (IEEE-1284 compliant)
! LocalTalk port
! EIO Slot

! Wireless Infrared port (IrDA compliant)

Networking ! The printer provides an EIO Slot for HP JetDirect 600 N print 
servers for fast and easy connectivity.

! Use in Workgroups to provide flexibility, fast printing through the 
network, and remote management.

Enhanced Memory 
and Memory 
Expansion 

! The HP LaserJet 2100 printer comes with 4 MB of memory and can 
be expanded to 52 MB with the three available memory (DIMM) 
slots. Most documents can be printed using the standard amount of 
printer memory through the aid of Memory Enhancement 
technology (MEt). MEt automatically compresses data, virtually 
doubling the printer’s memory and allowing more complex printing 
with available memory.

! The HP LaserJet 2100 M and 2100 TN printers come with 8 MB of 
memory and can be expanded to 40 MB with the two available 
memory (DIMM) slots. The third slot is used for the HP PS 
language DIMM.

Energy Savings ! The printer automatically conserves electricity by substantially 
reducing power consumption when not printing.

! As an ENERGY STAR partner, Hewlett-Packard Company has 
determined that this product meets ENERGY STAR guidelines for 
energy efficiency.

Economical Printing ! EconoMode (600 dpi only), manual duplexing, and N-up printing let 
you save paper, toner, and time.

! For tips on reducing the amount of paper use or extending the life of 
the toner cartridge, see “Printing Tasks” starting on page 35.
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Printer Software

The printer comes with helpful software including printer drivers and 
optional software. The printer drivers (Windows) and PPDs 
(Macintosh and Windows) provided must be installed to take full 
advantage of the printer’s features.

This section provides information in the following areas:

! Printer Software Installation Instructions

! Overview of Printing System Components

! Printer Software Installation Tips

Once you have followed the installation instructions and loaded the 
software, refer to the printer software tasks on page 44 on how to get 
the most out of your printer.

Note HP software is not available in all languages.

Check the ReadMe file provided on the compact disc or floppy disk for 
additional software included and supported languages. The most 
recent drivers, additional drivers, and other software are available from 
the Internet and other sources. If you do not have access to the Internet, 
see the HP Support pages at the front of this user guide to obtain the 
most recent software.

The HP LaserJet 2100 Series printer comes with drivers for the 
following platforms and operating environments. Find your operating 
system and follow the instructions to start the installation.

! “Windows Installation” on page 5

! “Macintosh Installation” on page 10 (HP LaserJet 2100 M)

! “DOS Installation” on page 12
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Windows Installation
1. Run the install program by following the instructions for your 

Windows version.

Note If you don’t have a CD-ROM drive, see page 13 for instructions.

2. Select installation type. The installer provides three options 
for software installation.

• Typical (recommended method): This option loads printer 
drivers, screen fonts, HP FontSmart, an uninstaller, and a 
configuration utility that will allow you to control all printing 
aspects.

• Minimal (for laptops and minimal installation): This option 
loads only the required printer driver and screen fonts.

• Custom (for experienced users and network administrators): 
This option allows you to choose which components will be 
installed. The installation program will prompt you to select the 
software items you wish to install. You must install at least one 
printer driver to use your printer. 

Windows Version To start installation:

Windows 9x/NT 4.0 a. Place compact disc in the CD-ROM drive. 
Install will start automatically.

b. Follow the on-screen instructions.
If the CD-ROM drive does not automatically 
run:
Select Run from the Start menu, and type 
x:\setup in the Open box (where x is the 
drive letter for the CD-ROM drive). Then 
follow the remaining installation instructions.

Windows 3.x a. Place the compact disc in the CD-ROM 
drive. 

b. From the File menu, select Run.

c. Type x:\setup (where x is the drive letter 
of your CD-ROM drive).

d. Follow the on-screen instructions. 
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3. Register your printer with HP.

If you have access to the World Wide Web, please take a moment to 
complete the registration for your HP LaserJet 2100 at the following 
website:

http://www.hp.com/go/lj2100_register

This will help Hewlett-Packard better provide support for your printer. 
After registering, you will have the option to receive valuable business 
tools. Hewlett-Packard will not contact you or send you information 
unless you explicitly approve it during the registration process. You 
may also register with the reply card included with your printer.

Software for Windows

Printer Drivers

Printer drivers access the printer’s features and allow the computer to 
communicate with the printer. Choose a printer driver based on the 
way you use the printer.

! Use the PCL 6 driver to take full advantage of the printer’s 
features. Unless complete backward compatibility with previous 
PCL drivers or older printers is necessary, the PCL 6 driver is 
recommended.

! Use the PCL 5e driver if you need print results to look consistent 
with those from older HP LaserJet printers. Certain features are 
not available in this driver. (Do not use the PCL 5e driver provided 
with this printer with older printers.)

! Use the PS driver for compatibility with PS needs. Certain printer 
features are not available in this driver.

If your printer has PS capabilities, the printer automatically switches 
between PS emulation and PCL printer languages depending on the 
driver you have selected.

Each printer driver has help screens that can be activated from the 
Help button, the F1 key, or a question mark symbol in the upper right 
corner of the printer driver (depending on the Windows operating 
system used). These help screens give detailed information about the 
specific driver. Printer driver help is separate from the software 
application help.
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Note For driver only or OEM setup, see the Readme on the installation CD.

HP FontSmart

Access HP FontSmart from the HP LaserJet folder or through the 
Start menu. HP FontSmart is a font management utility (for Windows 
only) which does the following:

! Installs, uninstalls, and deletes fonts.

! Manages fonts inside a single window by allowing you to drag-
and-drop.

! Shows the matching screen fonts for the internal fonts in the 
printer.

HP LaserJet Configuration Utility 
(Windows 9x/NT 4.0 only)

The HP LaserJet configuration utility manages printer default settings. 
It allows you to access many of the printer’s features, including:

! Printing PCL and PS test, font, and demo pages.

! Selecting page setup defaults.

! Choosing custom settings, such as reprint or tray locking.

! Setting resource options, such as IO buffering.

HP JetAdmin (CD-ROM only)

HP JetAdmin is designed to be used primarily by network 
administrators who are responsible for installing, configuring, 
troubleshooting, and maintaining printers and other devices on the 
network. Users may also use the status messages reported by 
HP JetAdmin to perform common troubleshooting (paper jams, paper 
out, etc.) and to confirm the current status of the printer on the 
network. HP JetAdmin can be accessed by clicking the Start button, 
pointing to Settings, and then clicking Control Panel in Windows 9x 
and Windows NT 4.0, or from the HP JetAdmin Utilities program 
group folder in Windows 3.x. Use HP JetAdmin to do the following:

! Install, configure, and manage printers on a network that are 
connected with a HP JetDirect 600 N print server.

! Perform in-depth diagnostics on the printer and network.

The HP JetAdmin software works on the following network systems:

! Windows NT ! Windows 9x
! SunOS* ! Novell NetWare
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*The software for these systems is not included on the compact disc 
with the printer, but is available from the Internet. If you do not have 
access to the Internet, see the HP Support pages at the front of this 
user guide to obtain this software.

Note Network Administrators: If the printer is attached to a network, before 
you can print, the printer must be configured for that network using 
HP JetAdmin or similar network software. 

! HP-UX* ! Solaris*
! Windows 3.x (Requires 

Novell NetWare Server)
! OS/2*

! Windows NT ! Windows 9x
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HP JetSend (CD-ROM - Windows 9x/NT 4.0 only)

HP JetSend is a new technology from Hewlett-Packard that allows 
devices to communicate with each other simply and directly. HP 
JetSend is built into your printer, allowing it to receive information 
from any JetSend-enabled sending device anywhere on your 
network, whether in the same office, or at a remote location. Your 
printer also has infrared capabilities, allowing it to receive information 
from any JetSend- enabled infrared device. Examples of JetSend 
sending devices include PC's or laptops running JetSend software, or 
scanners with JetSend built in. JetSend uses simple IP addressing 
between networked devices, and "Point and shoot" between infrared 
devices.

Visit the JetSend web site (www.jetsend.hp.com) for additional 
information on JetSend and JetSend software for the PC. JetSend 
allows you to exchange intra-company documents directly between 
PCs and between PCs and any JetSend-enabled printer, without the 
problems of incompatible software applications or versions. JetSend 
software will allow your colleagues to create documents on their PCs 
and send copies directly to this printer without any device-specific 
drivers or configuration difficulties.

You can visit the JetSend web site to learn which other devices are 
available to communicate easily and directly with your JetSend-
enabled printer.

How the JetSend Communications Technology Works

Networked Devices

To use the JetSend capability between networked devices (1) print a 
configuration page to find your JetSend IP address and (2) give your 
address to anyone who wishes to send information to your printer via 
JetSend.

From a JetSend sending device, a person only needs to enter the IP 
address of the printer and press "send."

Infrared Devices

To use the JetSend infrared capability, simply (1) line up the infrared 
sensors between the sending and receiving devices, and (2) choose 
the "send" option on the sending device.

The devices, because they have JetSend in them, will automatically 
negotiate the best possible outcome.

HP JetSend Software is not currently available for the Macintosh.
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Macintosh Installation
1. Run the install program by placing the compact disc in the 

CD-ROM drive. The installation window will appear on the 
desktop. Select the correct language and double-click the 
installer icon.

Note Virus protection must be turned off prior to starting the installation 
program.

The compact disc contains software for many international locales. 
Once you select the installation language and double-click Install in the 
desired language, the installation screen will appear in that language.

2. Select installation type. The installer provides two options 
for software installation.

• Typical (recommended method): This option loads the PPD, 
screen fonts, and a utility that controls all printing aspects.

• Custom (for experienced users and network administrators): 
This option allows you to choose which components will be 
installed. The installation program will prompt you to select the 
software items you wish to install.

3. Register your printer with HP.

If you have access to the World Wide Web, please take a moment to 
complete the registration for your HP LaserJet 2100 at the following 
website:

http://www.hp.com/go/lj2100_register

This will help Hewlett-Packard better provide support for your printer. 
After registering, you will have the option to receive valuable business 
tools. Hewlett-Packard will not contact you or send you information 
unless you explicitly approve it during the registration process. You 
may also register with the reply card included with your printer.

Note The Apple LaserWriter 8 driver must be installed to use the PPD. To 
make best use of the features of the printer, use the version of the 
LaserWriter driver included on the CD.
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Software For Macintosh Computers

PostScript Printer Description Files (PPDs)

PPDs, in combination with the LaserWriter driver, access the printer 
features and allow the computer to communicate with the printer. An 
installation program for the PPDs, LaserWriter driver, and other 
software is provided on the compact disc. 

HP LaserJet Utility

HP LaserJet Utility allows control over features that are not available 
in the driver. The illustrated screens make selecting printer features 
from the Macintosh computer easier than ever. Use the HP LaserJet 
Utility to do the following:

! Name the printer, assign it to a zone on the network, download 
files and fonts, and change most of the printer settings.

! Set a password for the printer.

! From the computer, lock out functions on the printer to prevent 
unauthorized access. 
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DOS Installation

DOS Remote Control Panel

1. Place the compact disc in the CD-ROM drive.

2. From the DOS prompt, type x: (where x is the drive letter of 
the CD-ROM drive), and press Enter. 

3. Change to the appropriate language directory 
(for example: cd\english).

4. Type install and press Enter.

If DOS applications are going to be used with the printer and the DOS 
Remote Control Panel was not installed, the AUTOEXEC.BAT file 
needs to be modified to prevent communication timeout errors. To 
modify the AUTOEXEC.BAT file, use any DOS editor, or any word-
processing program that edits ASCII text files, and follow the 
instructions below.

For DOS versions 4.0 and later, add:

MODE LPT1:,,B

For DOS versions earlier than 4.0, add:

MODE LPT1:,,P

Note The preceding examples assume you are using printer port LPT1. If 
you are using LPT2 or LPT3, replace LPT1 in the preceding examples 
with the appropriate printer port number.

Using the Remote Control Panel
The Remote Control Panel (RCP) enables you to change printer 
settings if the DOS software application does not support the printer 
feature you want to use. To start the RCP from DOS, follow these 
steps:

1. Make sure that the RCP is in the computer’s path statement. This 
can be checked by typing PATH at a DOS prompt at the root 
directory and pressing Enter. If the Remote Control Panel 
directory is not in the path statement, change to the default 
directory C:\HPLJUTIL.

2. At the DOS prompt, type RCP and press Enter.

3. For additional information, select Help.
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Software Installation Tips 

I do not have a CD-ROM drive.

If you have access to another computer with a CD-ROM drive, you 
can use the MakeDisk utility in Windows to create the disks you need 
for the installation. Follow the first step of the installation instructions, 
and choose MakeDisk to create the disks. 

If you have internet access, you can download drivers from the World 
Wide Web or HP’s FTP servers. The driver web page is: 

http://www.software.hp.com

For non-U.S. customers only: Use the floppy disk(s) supplied with the 
printer to install the software. 

If you do not have disks, see “HP Support” in the front of this guide for 
ordering information.

How do I access printer features?

Some printer features, such as custom paper sizes and page 
orientation, may be available through your application settings. Use 
application settings, if available, because they override printer driver 
settings.

Access advanced printer features through your printer driver. See 
“Software Tasks” on page 44 for instructions on using specific printer 
driver features. 

What additional drivers and software upgrades are 
available to me?

The latest printer drivers and printing software for HP LaserJet 
printers are available on the World Wide Web 
(http://www.software.hp.com). Check the “Readme” file for additional 
release information.
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What other software is available to me?

See “Printer Software” on page 4 for descriptions of the optional 
printing system software available for installation.

Note Check the ReadMe file provided on the compact disc for additional 
software included and supported languages. The most recent drivers, 
additional drivers, and other software are available from the Internet 
and other sources. If you do not have access to the Internet, see the 
HP Support pages at the front of this user guide to obtain the most 
recent software.

How do I remove the printing software?

In Windows, after installation, the Uninstall icon in the HP LaserJet 
program group allows you to select and remove any or all of the 
Windows HP printing system components.

Starting the Uninstaller:

1. In the HP LaserJet Program Group, double-click the Uninstall 
icon.

2. Click Next.

3. Select the HP printing system components you want to uninstall.

4. Click OK.

5. Follow the prompts.
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Control Panel 

Button Usage
The printer has two buttons: JOB CANCEL and GO.

Job Cancel

Press JOB CANCEL to cancel a job the printer is currently printing. The 
control panel lights will cycle while the print job is cleared from both 
the printer and the computer, and then return to ready. This may take 
some time, depending on the size of the print job.

l If JOB CANCEL is accidentally pushed, the job must be reprinted. 
There is no undo function. 

l If JOB CANCEL is pushed when the printer is idle, the top panel 
status lights will cycle, but nothing else will happen.

Go 
l Press GO to resume printing when the printer is paused or when 

unprinted data is still in the printer.

l Press GO to clear some printer errors.

l Press GO to print a demo page. The printer must be in the ready 
state.

!

Job Cancel 
Button

Attention Light

Ready Light

Go Light and 
Button
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Light Patterns
Light patterns provide both status and error messages. The lights can 
be in any one of the following states:

Control Panel Light Messages
The following control panel messages indicate various conditions of 
the printer in preparation for, or during, printing. If the Attention light is 
on, the printer is experiencing an error. See “Troubleshooting Error 
Messages” on page 99. 

Startup
The Go, Ready, and Attention lights cycle one after another.

The buttons have no effect until the printer is ready.

Ready
The Ready light is on and the printer is ready to print.

No action is needed.

Pressing the GO Button will print a demo page.

OnOff Blinking
16  Chapter 1 Printer Basics EN
Download from Www.Somanuals.com. All Manuals Search And Download.



Processing 
The printer is receiving or processing data.

Pressing JOB CANCEL cancels the current job. One or two pages may 
print as the printer clears the print job. The printer will return to the 
ready state after the job has been canceled.

Data 
The Ready light is blinking and the Go light is on. 

Data is in the printer memory waiting to be printed. Pressing the GO 
button prints from Tray 1 or from another tray if Tray 1 is empty and 
the paper size is supported in the other Tray.

Pressing the JOB CANCEL button cancels the current job and the 
printer returns to ready.

Manual Feed with Pause
The Go light is blinking. Pressing the Go button prints from Tray 1 or 
from another tray if Tray 1 is empty.

Pressing the JOB CANCEL button cancels the current job and the 
printer returns to ready.
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Paper Out 
The attention light is on. 

The printer is out of paper. The attention light will stay on until paper is 
added.

Pressing the GO or JOB CANCEL button has no effect.

Paper Out (requested tray) 
The GO light is on. 

The requested tray is out of paper. Adding paper to the requested tray 
causes the printer to start the print job from that tray. 

Pressing the GO button prints from another tray.

Pressing the JOB CANCEL button cancels the current job.

Attention
The printer requires attention for one of the following circumstances:

l door open

l toner cartridge missing

l paper jam

Pressing the GO button causes the printer to attempt to clear the 
paper jam.
18  Chapter 1 Printer Basics EN
Download from Www.Somanuals.com. All Manuals Search And Download.



Continuable Error
Pressing the GO button causes the printer to attempt to recover from 
the error and print whatever it can. If the recovery is unsuccessful, the 
printer will return to the continuable error state. See “Continuable 
Error” on page 100.

Service Error
The printer has experienced an error and cannot recover. All of the 
lights are on. See “Service Error” on page 101.

Accessory Error
The printer has experienced an error and cannot recover. All of the 
lights are blinking in unison. See “Accessory Error” on page 101.
EN Chapter 1 Printer Basics  19
Download from Www.Somanuals.com. All Manuals Search And Download.



Printing with the Infrared Port (Wireless Printing) 

The infrared (IR) port is located on the lower right corner of the 
printer. This port is compliant with the specifications determined by 
the Infrared Data Association (IrDA). On the right side of the IR port is 
a status light that indicates when the port is active. The IR port 
transmits data at speeds of up to 4 MB per second. When the IR 
connection is established, the IR status light comes on. If the 
connection is broken, or when the print job is complete, the IR status 
light goes off.

To use the IR port, you need the following:

l A computer or Personal Digital Assistant (PDA) equipped with an 
IrDA-compliant IR port.

l An infrared port driver that allows printing from the computer to 
the printer using the IR port and the IrDA communication 
protocol. 

l A printer driver to generate data that the printer can print.

Note Check with your hardware or operating system manufacturer for the 
correct port driver.

IR Status Light

IR Port
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Printing Instructions 
1. Make sure the printer is in ready state (Ready light on). 

2. Align an IrDA-compliant computer within 1 meter (3 feet) of the IR 
port. Ensure that the ports are facing each other with no more 
than a 15° angle to either the left and right or above and below. 
Send the print job from the computer. The IR status light will turn 
on when the connection has been made.

1 Meter
(3 Feet)

15°
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Interface Ports

The HP LaserJet 2100 and the 2100 M printers include two interface 
ports: an IEEE-1284 parallel and a LocalTalk port.

The HP LaserJet 2100 TN printer also includes an HP JetDirect 
600 N print server card that includes a 10Base-T (RJ-45) port.

LocalTalk port

RJ-45 port

Parallel port
(IEEE-1284) 
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Accessories and Ordering Information

The following list of accessories was current at the time of printing. 
Ordering information and availability of the accessories may change 
during the life of the printers.

Accessories

Option Description or Use Part Number

Toner Cartridge

Toner cartridge UltraPrecise toner cartridge 
Pallet Quantity

C4096A
C4097A

Memory and Language

Memory upgrades The HP LaserJet 2100 printer comes 
with 4 MB of memory and can be 
expanded to 52 MB with the 3 available 
memory (DIMM) slots.
The HP LaserJet 2100 M and 2100 TN 
printers come with 8 MB of memory and 
can be expanded to 40 M1B with the 2 
available memory (DIMM) slots. 

4 MB C4135A 
8 MB C4136A 
16 MB C4137A

HP PS DIMM The PS DIMM includes 4 MB of 
memory. This comes installed in the 
HP LaserJet 2100 M and 2100 TN 
printers.

C3098A 
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Cable and Interface Accessories

HP JetDirect 600 N EIO Print 
servers

Ethernet (10Base-T)
Ethernet (10Base-T,10Base2 LocalTalk)
TokenRing (RJ-45 and DB9)
Fast Ethernet (10/100Base-TX, RJ-45)

J3110A
J3111A
J3112A
J3113A

Parallel Cables (IEEE-1284) A=host computer connector (A-type) 
B=large printer connector (B-type)

2 Meter A to B C2950A
3 Meter A to B C2951A

LocalTalk Network Kit for 
Macintosh

Connect to a LocalTalk Network 92215N

Serial printer cable for 
Macintosh

Connect to a Macintosh computer 92215S

Paper Handling Accessories

250-Sheet Input Tray (Tray 3) 
and 
Feeder Unit

Tray (for Letter, Executive, Legal, A4, 
A5, B5 (ISO), B5 (JIS), and 8.5 by 13 
inch paper sizes)
The optional Tray 3 comes with the 
2100 TN printer.

C4793A

Tray 2 or optional Tray 3 
replacement

Tray (for Letter, Executive, Legal, A4, 
A5, B5 (ISO), B5 (JIS), and 8.5 by 13 
inch paper sizes)

RG5-4137

Media Accessories

HP Multi-purpose Paper HP brand paper for a variety of uses 
(1 box of 10 reams, 500 sheets each). 
To order a sample, in the U.S. call 
1-800-471-4701.

HPM1120

HP LaserJet Paper Premium HP brand paper for use with 
HP LaserJet printers (1 box of 10 
reams, 500 sheets each). To order a 
sample, in the U.S. call 
1-800-471-4701.

 HPJ1124

Accessories (continued)

Option Description or Use Part Number
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HP LaserJet Labels Letter (8.5 by 11 in.) white labels
Letter (8.5 by 11 in.) clear labels
A4 (210 by 297 mm) white labels
A4 (210 by 297 mm) clear labels

Call an authorized HP dealer for 
label sizes and availability.

Transparency Film Letter (8.5 by 11 in.) transparency film
A4 (210 by 297 mm) transparency film

92296T
92296U

Supplementary Documentation

HP LaserJet Printer Family 
Paper Specification Guide

A guide to using paper and other print 
media with HP LaserJet printers

5040-9092

HP LaserJet 2100, 2100 M, 
and 2100 TN Printers User 
Guide 

An additional copy of this user guide C4170-90901

To order HP LaserJet accessories and options see the “Worldwide Sales and Service Offices” on page 
124 for authorized HP dealers.

Accessories (continued)

Option Description or Use Part Number
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2 Printing Tasks

Overview

This chapter explains your printing options and gives common 
printing tasks:

! Preparing for Printing

! Media Input Options

! Loading Media into Tray 1

! Reloading Media into Tray 2 or Optional Tray 3

! Changing Paper Size in Tray 2 or Optional Tray 3

! Printing Tasks

! Canceling a Print Job

! Software Tasks
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Preparing for Printing

Purchasing Paper and Other Media
HP LaserJet printers produce excellent print quality documents. You 
can print on a variety of print media, such as paper (including up to 
100% recycled fiber content paper), envelopes, labels, overhead 
transparencies, and custom-sized media. Properties such as weight, 
grain, and moisture content are important factors affecting printer 
performance and output quality.

To achieve the best possible print quality, use only high-quality, 
copier-grade paper. See Appendix B for more detailed media 
specifications.

Note Always test a sample of paper before purchasing large quantities. 
Your paper supplier should understand the requirements specified in 
the HP LaserJet Printer Family Paper Specification Guide. See 
“Supplementary Documentation” on page 25.
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Media Input Options

The printer comes with two paper trays. By default, the printer draws 
first from Tray 1. If Tray 1 is empty, the printer draws from Tray 2 (or 
optional Tray 3 if it is installed).

Tray 1 Media Sizes
Tray 1 adjusts for sizes from 76 by 127 mm (3 by 5 in.) to a legal-size 
sheet, 216 by 356 mm (8.5 by 14 in.). Tray 1 should be used when 
printing:

l Envelopes (see page 35)

l Labels (see page 37)

l Transparencies (see page 38)

l Custom-sized media or cardstock (see page 39)

l Postcards (see page 39)

Tray 2

Tray 1

Optional Tray 3
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Tray 2 and Optional Tray 3 Paper Sizes
Tray 2 and optional Tray 3 have settings for the following paper sizes:

l A4

l A5

l B5 (ISO and JIS)

l Letter

l Legal 

l Executive

l 8.5 by 13 in.

See “Changing Paper Size in Tray 2 or Optional Tray 3” on page 33 to 
change the paper size. See “Supported Sizes of Paper” on page 140 
for specific dimensions.

CAUTION Use only paper from Tray 2 or optional Tray 3. Other types of printable 
media may jam if printed from Tray 2 or optional Tray 3. 
30  Chapter 2 Printing Tasks EN
Download from Www.Somanuals.com. All Manuals Search And Download.



Loading Media into Tray 1

Tray 1 (multi-purpose) holds up to 100 
sheets of paper or up to 10 envelopes.

1 Open Tray 1 by pulling the front 
cover down. 

2 Slide out the plastic tray extender. If 
the media being loaded is longer 
than 229 mm (9 in.), also flip open 
the tray extender. 

3 Slide the paper width guides slightly 
wider than the media. 

4 Place media into the tray (short-
edge in, print-side up). The media 
should be centered between the 
paper width guides and under the 
tabs on the paper width guides. 

5 Slide the paper width guides inward 
until they lightly touch the media 
stack on both sides without bending 
it. Make sure the media fits under 
the tabs on the paper width guides. 

Note
Do not add media to Tray 1 while the 
printer is printing. This could cause a 
paper jam. 

For preprinted material, see “Letterhead 
or Preprinted Forms Orientation” on 
page 42.

1

2

3

4

5

EN Chapter 2 Printing Tasks  31
Download from Www.Somanuals.com. All Manuals Search And Download.



Reloading Media into Tray 2 or Optional Tray 3

1 Pull the desired tray out of the 
printer. 

2 Push down on the metal paper lift 
plate to lock it in place. 

3 Add the media and make sure it is 
flat in the tray at all four corners. 
Keep the media below the height 
tabs on the paper length guide in 
the rear of the tray. 

4 Slide the tray back into the printer. 

Note
Whenever you remove a tray from the 
printer, always push down the metal 
paper lift plate before you put it back. 
The metal paper lift plate releases and 
lifts the paper up when you push the tray 
into the printer.

2

3

4

1
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Changing Paper Size in Tray 2 or Optional Tray 3

1 Pull the desired tray out of the 
printer and remove any paper. 

2 Press on the blue tab on the rear 
paper length guide to adjust for the 
paper length.

3 Adjust the paper length guide so the 
pointer matches the desired paper 
size.

4 Move the side width guides outward 
as far as possible.

5 Push down on the metal lift plate to 
lock it in place.

Continued on next page.

1

2

3

5

4
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6 Load up to 250 sheets into the 
paper tray. Make sure the paper is 
flat in the tray at all four corners. 
Keep the media below the height 
tabs on the paper length guide in 
the rear of the tray. 

7 Move the paper width guides inward 
so they touch the media on each 
side. The paper width guides will 
click into place for all sizes 
supported by the tray.

8 Slide the tray back into the printer.

8

7

6
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Printing Tasks

Printing on Envelopes

CAUTION
Before you load envelopes in Tray 1, 
make sure they are undamaged and are 
not stuck together. Never use envelopes 
with clasps, snaps, windows, coated 
linings, self-stick adhesives, or other 
synthetic materials. See Appendix B for 
media specifications.

1 Open Tray 1 by pulling the front 
cover down. 

2 Open the rear output bin by pulling 
down on the top section of the bin. 
Slide out the extender until it 
extends fully. 

Note
Using the rear output bin reduces 
envelope curl.

3 Slide the width guides on Tray 1 
outward slightly wider than the 
media. 

Continued on next page.

1

2

3
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4 Place the envelopes into the tray 
short-edge in, print-side up. The 
stamp end must enter the printer 
first. 

5 Slide the width guides inward until 
they lightly touch the envelope stack 
without bending it. The envelopes 
should be centered between the 
paper guides and under the tabs on 
the paper width guides. 

Note
If the envelope has a flap on the short 
edge, this edge must enter the printer 
first.

You may experience some paper jams 
when using any media with a length less 
178 mm (7 in.). This may be caused by 
paper that has been effected by 
environmental conditions. For optimum 
performance, make sure you are storing 
and handling the paper correctly. Please 
refer to “Printing and Paper Storage 
Environment” on page 144. Using media 
from another manufacturer may also 
help.

4

5
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Printing on Labels
Only use labels recommended for laser printers, such as HP LaserJet 
labels. See “Labels” on page 148 for specifications.

l Print labels from Tray 1. 

l Load labels print-side up.

l Use the rear output tray for labels.

l Remove label sheet from the output bin as they are printed to 
prevent them from sticking together. 

l Do not use labels that are separating from the backing sheet or 
are wrinkled or damaged in any way.

l Do not use label sheets with the backing sheet exposed or 
partially used label sheets.

l Do not feed a sheet of labels through the printer more than once. 
The adhesive backing is designed for one pass through the 
printer. 

CAUTION If a sheet of labels becomes jammed in the printer, remove the toner 
cartridge and then see “Clearing Paper Jams” on page 85 to remove 
the jammed labels.

Label Orientation
(Print-side up, top in)
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Printing on Transparencies
Only use transparencies recommended for use in laser printers, such 
as HP transparency film. Ordering information is located on page 25. 
Appendix B lists transparency specifications on page 149.

l Print transparencies from Tray 1.

l Use the top output tray to reduce curling (this is for 
transparencies only; for other media use rear output tray to 
reduce curling).

l To prevent transparencies from sticking together, remove any 
transparencies in the output tray as they are printed.

l Place transparencies on a flat surface after removing them from 
the printer. 
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Printing on Custom-Sized Media or Cardstock
Postcards, 3 by 5 in. (index) cards, and other custom-sized media can 
be printed from Tray 1. The minimum media size is 76 by 127 mm 
(3 by 5 in.) and the maximum media size is 216 by 356 mm (8.5 by 
14 in.).

Note You may experience some paper jams when using any media with a 
length less 178 mm (7 in.). This may be caused by paper that has been 
effected by environmental conditions. For optimum performance, make 
sure you are storing and handling the paper correctly. Please refer to 
“Printing and Paper Storage Environment” on page 144. Using media 
from another manufacturer may also help.

Custom-Sized Media and Cardstock Guidelines:

l Always insert the short-edge first into Tray 1. If you want to print in 
landscape mode, make this selection through your software. 
Inserting paper long-edge first may cause a paper jam.

l Use the rear output tray to reduce curl.

l Do not print on media smaller than 76 mm wide (3 in.) or 127 mm 
(5 in.) long.

l Set margins at least 6.4 mm (.25 in.) away from the edges of the 
media in the software application. 

See Appendix B starting on page 139 for media specifications.
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Printing on Both Sides of Media 
(Manual Duplexing)
l Print the first side of the media as you would normally. 

l Print the second side from Tray 1, making sure the printed side is 
facing down with the top-edge toward the printer.

l The PS Windows 9x and the Windows NT 4.0 printer driver as 
well as some software applications include “odd pages” and 
“even pages” printing. To use this option, flip down the rear output 
bin so that the paper will be stacked in the correct order. Print the 
even pages first as you would normally. Next, put the stack with 
the blank side up, top-edge toward the printer in Tray 1. Close the 
rear bin and print the odd pages.

Note When the second side is printing, you may experience a higher 
frequency of paper misfeeds, paper jams, and multi-feeds. Using the 
rear output bin may reduce these problems. The print quality may be 
different on the second side of the media. 
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Long and Short Edge Manual Duplexing

There are two ways to manually duplex, long edge or short edge 
binding. Long edge manual duplexing prints your document on both 
sides of the page with the binding on the long edge. Short edge 
duplexing prints the page with the binding on the short edge. 

Long  edge binding : Print the second side from Tray 1, making sure 
the printed side is facing down with the top-edge toward the printer. 

Short edge binding : Print the second side from Tray 1, making sure 
the printed side is facing down with the bottom-edge toward the 
printer. 
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Printing on Special Media

Letterhead or Preprinted Forms Orientation

Tray 1 letterhead orientation:  print-side up, top-edge toward the 
printer.

Tray 2 or optional Tray 3 letterhead orientation:  print-side down, 
top-edge toward you.
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Canceling a Print Job

A print job can be stopped from a software application, a print queue, 
or the JOB CANCEL button.

l If the printer has not started printing, first try to cancel the job 
within the software application that sent the print job. 

l If the print job is waiting in a print queue or print spooler such as 
the Print Manager in Windows 3.1 or Print Monitor in Mac, delete 
the job there. 

l If the print job is already printing, press the printer JOB CANCEL 
button. The printer will finish printing any pages that are already 
moving through the printer and delete the rest of the print job. 

If the control panel status lights continue to cycle after a job has been 
canceled the computer is still sending the job to the printer. Either 
delete the job from the print queue or wait until the computer has 
finished sending data. The printer will return to Ready (Go light on). 

Job Cancel Tips

Pressing JOB CANCEL cancels only the current job in the printer. If 
more than one print job is in printer memory, JOB CANCEL must be 
pressed once for each job.
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Software Tasks

This section lists the common printing tasks that are controlled 
through the printer software. Some printer drivers do not support all 
printer features. Use the PCL 6 printer driver to take full advantage of 
all the printer’s features, including:

Accessing the Printer Driver
After installation, you can access the printer driver through the 
operating system or from your software application. Although access 
to the printer driver from your software applications may vary, the 
printer driver is usually accessed from the File menu. 

Note The method for accessing a printer driver is the same, no matter which 
printer driver you are using.

l Watermarks l Quick Sets
l Custom Paper Size l Custom Print Quality Settings
l EconoMode l Selecting Paper Source
l Reduce/Enlarge l Restoring Defaults
l Resolution Enhancement 

technology (REt) 
l Printing Multiple Pages on 

One Sheet of paper (N-up 
printing)
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Using the Printer Driver Help
Each printer driver has help screens that can be activated from the 
Help button in the printer driver. These help screens give detailed 
information about the specific driver being used. Printer driver help is 
separate from the software application help.

Accessing the Driver

Operating System

Temporarily Change 
Settings (from a software 
application)

Change Default Settings
(across all applications)

Windows 9x/NT 4.0 From the File menu, click Print, and 
then click Properties. (The actual 
steps can vary; this is the most 
common method.)

Click the Start button, point to 
Settings, and then click Printers. 
Right-click the printer icon, and 
choose Properties. Many of the 
features in NT 4.0 printer drivers are 
also located on the Document 
Defaults menu.

Windows 3.x From the File menu, click Print, click 
Printers, and then click Options. 
(The actual steps can vary; this is 
the most common method.)

From the Windows control panel, 
double-click Printers, highlight the 
printer, and click Setup.

Macintosh
LaserWriter 8.3

From the File menu, select Print, 
and click Options.

From the File menu, select Print, 
and click Options. Click Save to 
save your changes.

Macintosh
LaserWriter 8.4 and higher

From the File menu, select Print. 
Click the pop-up for options you 
wish to change.

From the File menu, select Print. 
Click the pop-up for options you 
wish to change. Click Save to save 
your changes.
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Creating and Using Watermarks
The Watermark options allow you to specify that text be placed 
“underneath” (in the background) of an existing document. For 
example, you may want to have large gray letters reading “draft” or 
“confidential” placed diagonally across the first page or all pages of a 
document. 

Note Watermarks are available only with the HP PCL 6 (Windows), Windows 
NT 4.0 PS, and LaserWriter printer drivers.

Watermarks

Printer Driver Procedure

PCL 6 
(Windows 3.1/9x)

To use an existing watermark

1. Access the printer driver.

2. From the Effects tab, click the Watermarks drop-down 
list.

3. Click the desired watermark.

4. Click First Page Only, if desired.

5. Click OK.

To create or edit a watermark

1. Access the printer driver.

2. From the Effects tab, click Edit.

3. In the Watermark Details window, select the 
watermark you want to edit, or click New.

4. Select the desired watermark options.

5. Click OK.

6. From the Effects tab, click First Page Only, if desired.

7. Click OK.

To stop printing the watermark, click “none” in the 
Watermarks drop-down list.
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PCL 6 
(Windows NT 4.0)

To use an existing watermark

1. Click the Start button, point to Settings, then click 
Printers. Right-click the printer icon and choose 
Document Defaults.

2. From the Effects tab, click the Watermarks drop-down 
list.

3. Click the desired watermark.

4. Click First Page Only, if desired.

5. Click OK.

To stop printing the watermark, click “none” in the 
Watermarks drop-down list.

To create or edit a watermark

If you are running the printer driver from the server, you 
need administrator rights to save new watermarks.

1. Click the Start button, point to Settings, then click 
Printers. Right-click the printer icon and choose 
Document Defaults.

2. From the Effects tab, click Edit.

3. In the Watermark Details window, select the 
watermark you want to edit, or click New.

4. Select the desired watermark options.

5. Click OK.

6. From the Effects tab, click First Page Only, if desired.

7. Click OK.

To stop printing the watermark, click “none” in the 
Watermarks drop-down list.

Watermarks (continued)

Printer Driver Procedure
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Windows NT 4.0 PS To use an existing watermark

1. Access the printer driver.

2. From the Advanced tab, click Document Options, then 
Printer Features to expand their subentries.

3. Click on each desired Watermark option (Watermark, 
Watermark Font, Watermark Size, Watermark Angle, 
Watermark Style, and Print Watermark) and select the 
desired setting for each option.

4. Click OK.

To stop printing the watermark, click Watermark and select 
“none” in the Change ‘Watermark’ Setting box.

The Windows NT 4.0 PS printer driver does not support 
user-defined watermarks. If you want to create a 
watermark, use the HP PCL 6 printer driver.

Windows 9x PS To use an existing watermark

1. Access the printer driver.

2. From the Device Options tab, click on each desired 
Watermark option (Watermark, Watermark Font, 
Watermark Size, Watermark Angle, Watermark Style, 
and Print Watermark) and select the desired setting 
for each option.

3. Click OK.

To stop printing the watermark, click Watermark and select 
“none” in the Change ‘Watermark’ Setting box.

The Windows 9x PS printer driver does not support user-
defined watermarks. If you want to create a watermark, use 
the HP PCL 6 printer driver.

Macintosh
LaserWriter 8.3

1. Select Page Setup from the File menu.

2. Select Options.

3. Click the pop-up for each desired watermark option 
and select the desired setting.

4. Click OK.

To stop printing watermarks, select “None” or “Printer’s 
default” from the Watermark/Overlay pop-up.

Watermarks (continued)

Printer Driver Procedure
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Macintosh
LaserWriter 8.4 and 
higher

1. Select Page Setup from the File menu.

2. Click the pop-up and select Watermark/Overlay.

3. Click on each desired watermark option and select the 
desired setting. To use your own text, type text in the 
custom text box.

4. Click print.

To stop printing watermarks, select “None” in the layer 
option.

Watermarks (continued)

Printer Driver Procedure
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Printing Multiple Pages on One Sheet of Paper 
(N-up Printing)
You can select the number of pages you want to print on a single 
sheet of paper. If you choose to print more than one page per sheet, 
the pages will appear decreased in size and arranged on the sheet. 
You can specify up to 9 pages.

N-up Printing

Printer Driver Procedure

PCL 6 
(Windows 3.1/9x)

1. Access the printer driver.

2. From the Finishing tab, click Pages per Sheet.

3. Enter the number of pages you want to print per sheet 
(1, 2, 4, or 9).

4. Click Print Page Borders if you want to print a border 
around each page on the sheet. Print Page Borders is 
enabled only if Pages per Sheet is set to 2, 4, or 9.

5. Click OK.

PCL 6 
(Windows NT 4.0)

1. Access the printer driver.

2. From the Finishing tab, click Pages per Sheet.

3. Enter the number of pages you want to print per sheet 
(1, 2, 4, or 9).

4. Click Print Page Borders if you want to print a border 
around each page on the sheet. Print Page Borders is 
enabled only if Pages per Sheet is set to 2, 4, or 9.

5. Click OK.

Windows 9x PS 1. Access the printer driver.

2. From the Paper tab, click 1-, 2-, or 4-up.

3. Click OK.
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Windows NT 4.0 PS 1. Access the printer driver.

2. From the Advanced tab, click Document Options, then 
Printer Features to expand their subentries.

3. Click Pages per Sheet.

4. Select the desired option (1, 2, 4, 6, 9, or 16) in the 
Change ‘Pages per Sheet’ Setting box.

Select the Pages per Sheet orientation to match the 
orientation of your document. For example, a landscape 
presentation printed at 4 pages per sheet would use the 4 
(Landscape) Pages per Sheet setting.

5. Click OK.

Macintosh
LaserWriter 8.3

1. Select Page Setup from the File menu.

2. Select Layout.

3. Select the desired option (1, 2, or 4).

4. Click OK.

Macintosh
LaserWriter 8.4 and 
higher

1. Select Print from the File menu.

2. Select Layout.

3. Select the desired option (1, 2, 4, 6, 9, or 16).

4. Click OK.

N-up Printing (continued)

Printer Driver Procedure
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Setting a Custom Paper Size
Use the Custom Paper feature to print on paper sizes other than 
standard sizes.

Custom Paper Size

Printer Driver Procedure

PCL 6 
(Windows 3.1/9x)

1. Access the printer driver.

2. From the Paper tab, click Custom.

3. From the Custom Paper Size window, type the name 
of the custom paper size.

4. Click the desired unit of measure (millimeters or 
inches).

If you enter a size that is too small or too large, the driver 
will automatically adjust the size for you.

5. Enter the custom paper size length and width.

6. Click OK.

You can save up to five custom paper sizes for reuse.

Windows NT 4.0 The Windows NT printer drivers do not support custom 
paper sizes. You may access custom sizes through the 
operating system.

1. Click the Start button, point to Settings, then click 
Printers.

2. From the File menu, click Server Properties.

3. From the Forms tab, click Create New Form.

4. Set the custom paper size and margins.

5. Click OK.
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Windows 9x PS 1. Access the printer driver.

2. From the Paper tab, scroll to the right of the Paper 
Size box and click Custom Page.

3. Click the Custom button.

4. From the Custom-Defined Size window, type the 
name of the custom paper size.

5. Click the desired unit of measure (millimeters or 
inches).

6. Enter the custom paper size length and width.

7. Click OK.

You can save up to three custom paper sizes for reuse.

Macintosh
LaserWriter 8.3

1. Select Page Setup from the File menu.

2. Select Custom.

3. Click the paper image to select the paper size. 

Macintosh
LaserWriter 8.4

The 8.4 version does not support this option. Use the 8.3 
version to use custom paper sizes, or check with Apple for 
updated drivers.

Macintosh
LaserWriter 8.5 and 
higher

1. Select Page Setup from the File menu.

2. Select Custom page Sizes from the Page attributes 
pop-up.

3. Select New to create custom page sizes or select Edit 
for existing custom pages.

4. Click OK.

Custom Paper Size (continued)

Printer Driver Procedure
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Creating and Using Quick Sets
Quick Sets allow you to save the current driver settings (for example, 
page orientation, n-up printing or paper source) for reuse. For 
convenience, Quick Sets can be selected and saved from most 
printer driver tabs. You can also restore printer driver default settings 
by selecting Defaults from the Quick Sets drop-down list.

Note Quick Sets are available only with the HP PCL 6 printer driver for 
Windows. 

Quick Sets

Printer Driver Procedure

PCL 6 
(Windows 3.1/9x)

Creating Quick Sets

1. Access the printer driver.

2. Select the desired print settings.

3. In the Quick Sets box, type a name for the selected 
settings (for example “Quarterly Report” or “My 
Project Status”).

4. Click Save.

5. When you save Quick Sets, all current driver settings 
are saved. The printer driver will now remember these 
settings. 

6. Click OK.

Using Quick Sets

1. Access the printer driver.

2. Select the desired item from the Quick Sets drop-
down list.

3. Click OK. The printer is now set to print according to 
the settings in the Quick Sets you selected.
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PCL 6 
(Windows NT 4.0)

Creating Quick Sets

If you are running the printer driver from the server, you 
need administrator rights to save new Quick Sets.

1. Click the Start button, point to Settings, then click 
Printers. Right-click the printer icon and choose 
Document Defaults. You can save Quick Sets from 
any tab.

2. Select the desired print settings.

3. In the Quick Sets box, type a name for the selected 
settings (for example “Quarterly Report” or “My 
Project Status”).

4. Click Save. When you save Quick Sets, all current 
driver settings are saved. The printer driver will now 
remember these settings. 

5. Click OK.

Using Quick Sets

1. Access the printer driver.

2. Select the desired item from the Quick Sets drop-
down list.

3. Click OK.

Quick Sets (continued)

Printer Driver Procedure
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Using EconoMode
EconoMode (Save Toner) allows the printer to use less toner on each 
page. Selecting this option will extend the life of your toner cartridge 
and reduce your cost per page, but will reduce print quality. This 
setting is not available with 1200 dpi settings.

EconoMode

Printer Driver Procedure

PCL 6 
(Windows 3.1/9x)

1. Access the printer driver.

2. From the Finishing tab, click EconoMode (Save 
Toner). If the box is checked, EconoMode is enabled. 
If the box is empty, EconoMode is disabled.

3. Click OK.

PCL 6 
(Windows NT 4.0)

1. Click the Start button, point to Settings, then click 
Printers. Right-click the printer icon and choose 
Document Defaults.

2. From the Finishing tab, click EconoMode (Save 
Toner). If the box is checked, EconoMode is enabled. 
If the box is empty, EconoMode is disabled.

3. Click OK.

Windows 9x PS 1. Access the printer driver.

2. From the Device Options tab, click EconoMode.

3. Select the desired EconoMode option in the Change 
Setting in EconoMode drop-down list.

4. Click OK.

Windows NT 4.0 PS 1. Access the printer driver.

2. From the Advanced tab, click Document Options, then 
Printer Features to expand their subentries.

3. Click EconoMode.

4. Select the desired EconoMode option in the Change 
‘EconoMode’ Setting box.

5. Click OK.
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Macintosh
LaserWriter 8.3

1. Select Print from the File menu.

2. Click Options.

3. Select the desired EconoMode setting.

4. Click OK.

Macintosh
LaserWriter 8.4 and 
higher

1. Select Print from the File menu.

2. Click the popup for print options and select Imaging 
Options.

3. In the Imaging Options dialog, select the desired 
EconoMode setting.

4. Click Print.

EconoMode (continued)

Printer Driver Procedure
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Choosing Print Quality Settings
The printer’s default print quality setting is Best Quality, which uses 
1200 dpi to provide the best combination of print speed and print 
quality. If you need advanced print quality, you can choose custom 
settings. 

Resolution Options:

l Best Quality  (default) - 1200 dpi for the best print quality.

l Faster Printing  - 600 dpi, alternate resolution for complex 
graphics or faster output. 

l Custom  - Allows you to specify print quality settings.

Note Changing resolution may change the formatting of your text.

Choosing Print Quality Settings

Printer Driver Procedure

PCL 6 
(Windows 3.1/9x)

1. Access the printer driver.

2. From the Finishing tab, click Custom, then Details.

3. In the Print Quality Details window, select the desired 
resolution setting.

4. Click OK.

PCL 6 
(Windows NT 4.0)

1. Click the Start button, point to Settings, then click 
Printers. Right-click the printer icon and choose 
Document Defaults.

2. From the Finishing tab, click Custom, then Details.

3. In the Print Quality Details window, select the desired 
resolution setting.

4. Click OK.

Windows 9x PS 1. Access the printer driver.

2. From the Graphics tab, select the desired resolution 
setting.

3. Click OK.
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Windows NT 4.0 PS 1. Access the printer driver.

2. From the Advanced tab, click Graphics to expand its 
subentries.

3. Click Resolution.

4. Select the desired Resolution option in the Change 
‘Resolution’ Setting box. (1200 is the same as best 
quality in the PCL 6 printer driver.)

5. Click OK.

Macintosh
LaserWriter 8.3

1. Select Print from the File menu.

2. Click Options.

3. In the Print Options dialog, select the desired Print 
Resolution setting.

4. Click OK.

Macintosh
LaserWriter 8.4 and 
higher

1. Select Print from the File menu.

2. Click the pop-up for print options and select 
Resolution Options.

3. In the Resolution Options dialog box, select the 
desired setting.

4. Click Print.

Choosing Print Quality Settings (continued)

Printer Driver Procedure
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Using Reduce/Enlarge Options
Reduce/Enlarge options allow you to scale your document to a 
percent of its normal size. You can also choose to scale your 
document to fit on letter- or A4-size paper.

Reduce/Enlarge

Printer Driver Procedure

PCL 6 
(Windows 3.1/9x)

1. Access the printer driver.

2. From the Effects tab, type the percentage by which 
you want to reduce or enlarge your document or click 
Fit to Letter Size or click Fit to A4 Size.

3. Click OK.

PCL 6 
(Windows NT 4.0)

1. Click the Start button, point to Settings, then click 
Printers. Right-click the printer icon and choose 
Document Defaults.

2. From the Effects tab, type the percentage by which 
you want to reduce or enlarge your document.

3. Click OK.

Windows 9x PS To reduce or enlarge your document

1. Access the printer driver.

2. From the Graphics tab, type the percentage by which 
you want to reduce or enlarge your document in the 
Scaling box.

3. Click OK.

To fit your document to letter- or A4-size paper

1. Access the printer driver.

2. From the Device Options tab, click Fit to Page.

3. Select the desired Fit to Page option in the Change 
Setting for: drop-down list.

4. Click OK.
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Windows NT 4.0 PS To reduce or enlarge your document

1. Access the printer driver.

2. From the Advanced tab, click Graphics to expand its 
subentries.

3. Click Scaling.

4. Type the percentage by which you want to reduce or 
enlarge your document in the Change ‘Scaling’ 
Setting box.

5. Click OK.

To fit your document to letter- or A4-size paper

This setting works for all paper sizes in the Windows NT 4.0 
PS printer driver.

1. Access the printer driver.

2. From the Advanced tab, click Document Options, then 
Printer Features to expand their subentries.

3. Click Fit to Page.

4. Select the desired option in the Change ‘Fit to Page’ 
Setting box.

5. Click OK.

Macintosh
LaserWriter 8.3

1. Select Page Setup from the File menu.

2. Select Reduce/Enlarge.

3. Select the desired settings. 

4. Click OK.

Macintosh
LaserWriter 8.4 and 
higher

1. Select Page Setup from the File menu.

2. Select Scale.

3. Select the desired settings. 

4. Click OK.

Reduce/Enlarge (continued)

Printer Driver Procedure
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Selecting a Paper Source
If your application supports printing paper by source, make the 
selections from your application. Application settings override printer 
driver settings.

Selecting Paper Source

Printer Driver Procedure

PCL 6 
(Windows 3.1/9x)

1. Access the printer driver.

2. From the Paper tab, select the desired Source of 
paper.

3. Click OK.

PCL 6 
(Windows NT 4.0)

1. Click the Start button, point to Settings, then click 
Printers. Right-click the printer icon and choose 
Document Defaults.

2. From the Paper tab, select the desired Source of 
paper.

3. Click OK.

Windows 9x PS 1. Access the printer driver.

2. From the Paper tab, select the desired Paper Source 
option in the Paper Source drop-down list.

3. Click OK.

Windows NT 4.0 PS 1. Access the printer driver.

2. From the Page Setup tab, select the desired paper 
source from the Paper Source drop-down list.

3. Click OK.

Macintosh
LaserWriter 8.3

1. Select Print from the File menu.

2. Choose paper source.

3. Select the desired selection.

4. Click OK.

Macintosh
LaserWriter 8.4 and 
higher

1. Select Print from the File menu.

2. Click the Paper Source pop-up. 

3. Select the desired source.

4. Click Print.
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Using REt
When REt (Resolution Enhancement technology) is on, it refines the 
print quality of characters by smoothing out jagged edges that can 
occur on the angles and curves of a printed image. Choose Off if 
graphics, particularly scanned images, are not printing clearly.

Note REt is disabled when 1200 dpi settings are selected.

REt

Printer Driver Procedure

PCL 6 
(Windows 3.1/9x)

1. Access the printer driver.

2. From the Finishing tab, click Custom, then Details.

3. In the Print Quality Details window, select the REt 
desired option (On or Off).

4. Click OK.

PCL 6 
(Windows NT 4.0)

1. Click the Start button, point to Settings, then click 
Printers. Right-click the printer icon and choose 
Document Defaults.

2. From the Finishing tab, click Custom, then Details.

3. In the Print Quality Details window, select the REt 
desired option (On or Off).

4. Click OK.

Windows NT 4.0 PS 1. Access the printer driver.

2. From the Advanced tab, click Document Options, then 
Printer Features to expand their subentries.

3. Click Resolution Enhancement.

4. Select the desired Resolution Enhancement option in 
the Change ‘Resolution Enhancement’ Setting box.

5. Click OK.
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Windows 9x PS 1. Access the printer driver.

2. From the Device Options tab, select the desired 
Resolution Enhancement option from the Printer 
Features drop-down list.

3. Select the desired Resolution Enhancement option in 
the Change setting for ‘Resolution Enhancement’ 
drop-down list.

4. Click OK.

Macintosh
LaserWriter 8.3

1. Select Print from the File menu.

2. Click Options.

3. In the Print Options dialog, select the desired 
Resolution Enhancement setting. 

4. Click OK.

Macintosh
LaserWriter 8.4 and 
higher

1. Select Print from the File menu.

2. Click the pop-up for print options and select 
Resolution Options.

3. In the Resolution Options dialog box, select the 
desired Resolution Enhancement setting.

4. Click Print.

REt (continued)

Printer Driver Procedure
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Restoring Default Printer Driver Settings

Restoring Defaults

Printer Driver Procedure

PCL 6 
(Windows 3.1/9x)

1. Access the printer driver.

2. In the Quick Sets box, click Defaults 

PCL 6 
(Windows NT 4.0)

1. Click the Start button, point to Settings, then click 
Printers. Right-click the printer icon and choose 
Document Defaults.

2. In the Quick Sets box, click Defaults 

Windows 9x PS 1. Access the printer driver.

2. Click the Restore Defaults button for each tab where 
you want to restore default settings.

Windows NT 4.0 PS The Windows NT 4.0 PS printer driver invokes default 
settings when an application is started. To restore default 
printer settings without restarting your application, select 
another printer driver, then select the Windows NT 4.0 PS 
printer driver.

Macintosh
LaserWriter 8.3

To restore default printer driver settings, delete the 
“LaserWriter 8 Prefs” file in the Preferences folder in the 
System folder. 

Macintosh
LaserWriter 8.4 and 
higher

1. Open the Preferences folder.

2. Open the Printing Prefs folder.

3. Open the Parsed PPD folder.

4. In the Parsed PPD Folder, delete the file with the 
same name as the printer. For example, for a printer 
called HP LaserJet 2100 M, delete the file 
HP LaserJet 2100 M.PPD in the following path: 
HD:System Folder:Preferences:Printing Prefs:Parsed 
PPD Folder:HP LaserJet 2100 M
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Printing on Different Paper for the First Page 

Note Printing on different paper for the first page of a print job is available 
only with the HP PCL 6 printer and Macintosh LaserWriter driver. 

Some applications may also have this feature. Check with the 
application’s help file.

Printing on Different Paper for the First Page

Printer Driver Procedure

PCL 6 
(Windows 3.1/9x)

1. Access the printer driver.

2. From the Paper tab, select the desired paper for the 
first page of your print job.

3. Click Use different paper for first page.

4. Click the Other Pages tab.

5. Select the desired paper source for the other pages of 
your print job.

PCL 6 
(Windows NT 4.0)

1. Click the Start button, point to Settings, then click 
Printers. Right-click the printer icon and choose 
Document Defaults.

2. From the Paper tab, select the desired paper for the 
first page of your print job.

3. Click Use different paper for first page.

4. Click the Other Pages tab.

5. Select the desired paper source for the other pages of 
your print job. 
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Note The paper size for all pages of the print job must be the same in the 
driver.

Macintosh
LaserWriter 8.3

1. Select Print from the File menu.

2. Select First From and then select the desired tray for 
the first page from the pop-up menu.

3. Select the tray for the rest of the job from the 
Remaining From pop-up menu.

Macintosh
LaserWriter 8.4 and 
higher

1. Select Print from the File menu.

2. Select First Page From and then select the desired 
tray for the first page from the pop-up menu.

3. Select the tray for the rest of the job from the 
Remaining From pop-up menu.

Printing on Different Paper for the First Page (continued)
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Tray Locking
Tray Locking is a feature that allows you to “lock” a tray so that the 
only time the printer will draw from that tray is when it is specifically 
requested. This is useful when you want to put special paper in a tray, 
such as letterhead. For example, if you are using “First Available 
Tray,” for the paper source and you lock Tray 1, the printer will only 
draw from the remaining trays, either Tray 2 or optional Tray 3, if it is 
installed. You can still print from the locked tray, but you must specify 
the source.

Note The feature will not allow you to lock all the trays. One tray must be 
“unlocked.”

Tray Locking

Printer Utility Procedure

Windows 1. Run the HP LaserJet configuration utility or JetAdmin.

2. From the Custom tab, select the tray you wish to lock.

Macintosh 1. Run the HP LaserJet Utility.

2. From the Settings Panel, select Input Trays.

3. Click on the tray you want to lock.
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3 Printer Tips and 
Maintenance 

Overview

This chapter provides suggestions for high-quality and economical 
printing. It also lists special maintenance tasks for the toner cartridge 
and the printer. 

l Managing the UltraPrecise Toner Cartridge

l Redistributing the Toner

l Cleaning the Printer

l Using the Printer Cleaning Processes
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Managing the UltraPrecise Toner Cartridge

HP Policy on Non-HP Toner Cartridges
Hewlett-Packard Company cannot recommend use of non-HP toner 
cartridges, either new, refilled, or remanufactured. Because they are 
not HP products, HP cannot influence their design or control their 
quality.

Toner Cartridge Storage
Do not remove the toner cartridge from its package until you are 
ready to use it. The shelf life of a cartridge in an unopened package is 
approximately 2.5 years. The shelf life of a cartridge in an opened 
package is approximately 6 months.

CAUTION To prevent damage to the toner cartridge, do not expose it to light for 
more than a few minutes.

Toner Cartridge Life Expectancy
The life of the toner cartridge depends on the amount of toner that 
print jobs require. When printing text at 5% coverage, an HP LaserJet 
2100 toner cartridge lasts an average of 5,000 pages. This assumes 
the print density is set to 3 and EconoMode is off. (These are the 
default settings.)

Recycling Toner Cartridges
To install a new HP toner cartridge and recycle the used cartridge, 
follow the instructions included in the new toner cartridge box.

See “HP Toner Cartridges” on page 133.
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Redistributing the Toner

When toner is low, faded or light areas 
may appear on a printed page. You may 
be able to temporarily improve print 
quality by redistributing the toner. The 
following procedure may allow you to 
finish the current print job before 
replacing the toner cartridge.

1 Open the top cover. 

2 Remove the toner cartridge from 
the printer. 

WARNING!
Avoid reaching too far into the printer. 
The adjacent fusing area may be hot!

CAUTION
To prevent damage, do not expose the 
toner cartridge to light for more than a 
few minutes. 

3 Rotate the toner cartridge and 
gently shake from side to side to 
redistribute the toner. (Do not tip the 
cartridge on end, or it might leak.)

Continued on next page.

2

1

3
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Note
If toner gets on your clothing, wipe it off 
with a dry cloth and wash clothing in cold 
water. (Hot water sets toner into fabric.)

4 Reinsert the toner cartridge into the 
printer and close the top cover.

If the print remains light, install a new 
toner cartridge. (Follow the instructions 
provided with the new toner cartridge.)

4
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Cleaning the Printer

To maintain print quality, follow the cleaning procedures on the 
following pages every time the toner cartridge is changed or 
whenever print quality problems occur. As much as possible, keep the 
printer free from dust and debris.

l Clean the outside of the printer with a lightly water-dampened 
cloth.

l Clean the inside with a dry, lint-free cloth.

CAUTION Do not use ammonia-based cleaners on or around the printer. While 
cleaning the printer, be careful not to touch the transfer roller (located 
underneath the toner cartridge). Skin oils on the roller can cause print 
quality problems. 

Using the Printer Cleaning Processes
During the printing process, paper, toner and dust particles can 
accumulate inside the printer. Over time, this buildup can cause print 
quality problems such as toner specks or smearing. This printer has 
two cleaning modes that can correct and prevent these types of 
problems. 

Note In order for the engine cleaning page to work properly, print the page 
on copier-grade paper, not bond or rough paper.

Engine Cleaning

This process uses copier-grade paper from Tray 2 to remove dust and 
toner from the paper path. Use this process if you are experiencing 
toner specks or dots on printouts. This process will provide a blank 
page which should be discarded. See “Starting the Cleaning Process” 
on page 74.

Toner Cartridge Cleaning 

This process cleans the drum inside the toner cartridge. Use this 
process if you are experiencing blurred, faded or smeared printouts. 
This process will take about 10 minutes. See “Starting the Cleaning 
Process” on page 74.
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Note Make sure the toner cartridge is not empty when using the toner 
cartridge cleaning. A near empty toner cartridge may also cause print 
defects. This 10-minute process consumes toner and if used often can 
reduce toner cartridge life. 

Starting the Cleaning Process
1. Make sure the printer is turned on and in the ready state. Make 

sure there is paper loaded in Tray 2.

2. Press and hold the Go and Job Cancel buttons until all lights 
flash. This will take about 10 seconds. Release the buttons when 
the lights flash.

3. For engine cleaning, press the Go button,
or
for cartridge cleaning, press the Job Cancel button.

4. Discard the blank page produced from the engine cleaning 
process.

Note The cartridge cleaning process takes about 10 minutes. To stop the 
toner cartridge cleaning process, turn the printer off.
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Internal Cleaning Procedure 
Over time, particles of toner and paper 
will begin to accumulate inside the 
printer. This may cause print quality 
problems during printing. Cleaning the 
printer will eliminate or reduce these 
problems.

WARNING!
Before cleaning the printer, turn the 
printer off and unplug the power cable.

1 Open the top cover. 

2 Remove the toner cartridge.

CAUTION
To prevent damage, do not expose the 
toner cartridge to light for more than a 
few minutes. Place a piece of paper over 
the top of the toner cartridge to shield it 
while it is out of the printer.

3 With a dry, lint-free cloth, wipe any 
residue from the paper path area 
and the toner cartridge cavity. 

4 Replace the toner cartridge and 
close the top cover. Plug in the 
power cable, and turn the printer 
on. 

2

3

1

4
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4 Problem Solving

Overview

This chapter helps you troubleshoot printer problems in the following 
areas:

l Troubleshooting Checklist

l Troubleshooting General Printing Problems

l Printing Special Pages

l Clearing Paper Jams

l Solving Print Quality Problems

l Infrared Printing Problems

l Troubleshooting Error Messages

l Secondary Light Patterns

l Network Problems

l Common Windows Problems

l Common Macintosh Problems

l Troubleshooting PS Errors
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Troubleshooting Checklist 

If the printer is not responding properly, complete the following 
checklist in order. If the printer does not pass a step, follow the 
corresponding troubleshooting suggestions.

Troubleshooting Checklist

Make sure the printer 
Ready light is on.

If no lights are on, check the power cord 
connections. Check the power switch. Check the 
power source by plugging into another outlet.

If other lights are on, go to “Troubleshooting Error 
Messages” on page 99.

Press GO to print a 
demo page to verify 
that the printer is 
feeding paper correctly.

If a demo page does not print, check the paper 
supply in Tray 2 or Tray 3. 

If the page jams in the printer, go to “Clearing Paper 
Jams” on page 85.

If the printer prints, but you get an error message, go 
to “Troubleshooting Error Messages” on page 99.

Check the demo page 
to see if it printed 
correctly.

If there is a print quality problem, go to “Solving Print 
Quality Problems” on page 91.
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Print a short document 
from a software 
application to verify the 
computer and printer 
are connected and are 
communicating 
correctly.

If the page does not print, check the cable 
connection between the printer and computer. Make 
sure you are using the proper cable.

Check the print queue or print spooler (print monitor 
in Mac) to see if the printer has been paused.

Check the software application to make sure you are 
using the proper printer driver and port.
If the page is interrupted during printing, go to 
“Troubleshooting General Printing Problems” on 
page 80.

If completing the 
checklist did not 
diagnose the problem 
with the printer, check 
the following 
troubleshooting 
sections:

“Troubleshooting General Printing Problems” on 
page 80
“Infrared Printing Problems” on page 97
“Troubleshooting Error Messages” on page 99
“Secondary Light Patterns” on page 102
“Network Problems” on page 107
“Common Windows Problems” on page 108
“Common Macintosh Problems” on page 110
“Troubleshooting PS Errors” on page 114

Troubleshooting Checklist (continued)
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Troubleshooting General Printing Problems

Troubleshooting General Printing Problems

Symptom Possible Cause Solution

Printer selects media from the 
wrong tray.

The tray selection in the 
software application may be 
incorrect.

For many software 
applications, the paper tray 
selection is found under the 
Page Setup menu within the 
application.

Remove any media in other 
trays to make the printer select 
from the desired tray.

For Macintosh, use the 
LaserJet Utility to change the 
priority of the tray.

Print job is extremely slow. The job may be very complex.

The maximum speed of 10 
pages per minute cannot be 
exceeded even when more 
memory is added.

Reduce the complexity of the 
page or try adjusting the print 
quality settings. If this problem 
occurs frequently, add memory 
to the printer.

Pages print, but are totally 
blank.

The sealing tape may still be in 
the toner cartridge. 

Remove the toner cartridge 
and pull out the sealing tape. 
Re-install the toner cartridge. 
Check the printer by pressing 
GO to print a demo page. 

The file may have blank 
pages. 

Check file to make sure that it 
does not contain blank pages.
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The printer prints, but the text 
is wrong, garbled, or 
incomplete.

The parallel cable is loose or 
defective.

Disconnect the parallel cable 
and reconnect it. Try a print job 
you know works. If possible, 
attach the cable and printer to 
another computer and try a 
print job that you know works. 
Finally, try a new IEEE-1284 
compliant cable or a LocalTalk 
cable (Mac).

The printer is on a network or 
sharing device and is not 
receiving a clear signal.

Disconnect the printer from 
the network and attach it 
directly to a computer with a 
parallel cable. Print a job that 
you know works. If it prints 
properly, check with your 
network administrator.

The wrong driver was selected 
in the software.

Check the software’s printer 
selection menu to make sure 
that the HP LaserJet 2100 is 
selected.

The software application is 
malfunctioning.

Try printing a job from another 
application.

The operating system is 
malfunctioning.

If printing from Windows (any 
version), exit to a DOS prompt 
and verify functionality with the 
following command: At a 
C:\prompt, type Dir LPT1
then press enter. (This 
assumes you are connected to 
LPT1). If the Go light comes 
on, press the Go button to 
print and eject the page.

The printer does not respond 
when “print” is selected in the 
software.

The printer may be in manual 
feed mode (Go Light Blinking).

Add paper to Tray 1 and press 
and release the Go button.

Troubleshooting General Printing Problems (continued)

Symptom Possible Cause Solution
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The parallel cable between the 
computer and the printer is not 
connected properly.

Disconnect and reconnect the 
parallel cable.

The parallel cable is defective. If possible, attach the cable to 
another computer and print a 
job you know works. You may 
also try using a different 
parallel cable (IEEE-1284 
Compliant) or LocalTalk cable 
(Mac).

The wrong printer was 
selected in the software.

Check the software printer 
selection menu to make sure 
that the HP LaserJet 2100 is 
selected.

. The software for the printer is 
not configured for the printer 
port.

Check the software’s printer 
selection menu to make sure it 
is accessing the correct port. If 
the computer has more than 
one parallel port, make sure 
the printer is attached to the 
correct one.

The printer is on a network 
and is not receiving a signal.

Disconnect the printer from 
the network and attach it 
directly to a computer with a 
parallel cable. Print a job you 
know works. If it prints 
properly, check with your 
network administrator.

The printer is not receiving 
power.

If no lights are on, check the 
power cord connections. 
Check the power switch. 
Check the power source. 

Troubleshooting General Printing Problems (continued)

Symptom Possible Cause Solution
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The printer does not respond 
when “print” is selected in the 
software.

The printer is malfunctioning. Check the lights on the printer 
to determine if the printer is 
indicating an error.

The Attention light stays on. The printer is out of paper. Add paper to the printer.

Paper trays are installed 
incorrectly.

Make sure that Tray 2 or 
optional Tray 3 are pushed in 
all the way.

The Attention light is blinking The top cover of the printer is 
open.

Close the top cover securely.

The toner cartridge is missing 
or not installed correctly.

Make sure the toner cartridge 
is installed. Try removing the 
cartridge and re-installing it.

There is a paper jam in the 
printer.

See “Clearing Paper Jams” on 
page 85.

Troubleshooting General Printing Problems (continued)

Symptom Possible Cause Solution
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Printing Special Pages

There are special pages within the memory of the printer that will help 
you to diagnose and learn about problems with your printer.

Demo Page
To print the demo page, press the GO button when the printer is 
ready.

Configuration Page
The configuration page lists many of the current settings and 
properties of the printer. To print the configuration page, press and 
release the GO and JOB CANCEL buttons simultaneously when the 
printer is ready. If you have an EIO card installed, a second page will 
print listing all of the EIO information.

Cleaning Process
The printer has two cleaning processes, Engine and Toner Cartridge 
cleaning. These clean internal areas including the paper path and the 
toner cartridge. The Engine cleaning process produces a blank page 
that should be discarded. See “Using the Printer Cleaning Processes” 
on page 73.

Font List
To print a font list, use either HP FontSmart (Windows) or the 
HP LaserJet Utility (Macintosh). 
84  Chapter 4 Problem Solving EN
Download from Www.Somanuals.com. All Manuals Search And Download.



Clearing Paper Jams 

Occasionally, paper can become jammed during a print job. Some of 
the causes include:

l Paper trays loaded improperly or overfilled.

l Tray 2 or optional Tray 3 is removed during a print job.

l Top cover is opened during a print job.

l Media that does not meet HP specifications is used. See “Media 
Specifications” on page 139.

l Media that is outside of the supported size range is used. See 
“Media Specifications” on page 139.

Find and remove the jammed paper using the instructions on the 
following pages. If the location of the paper jam is not obvious, look 
first in the toner cartridge area. 

Paper jams can occur at three locations:

l Tray 2 or optional Tray 3 paper feed area. 

l Toner cartridge area.

l Output areas. 

Note Loose toner may remain in the printer after a paper jam. This should 
clear after a few sheets have printed. See “Loose Toner” on page 94.
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Paper Jam: Toner 
Cartridge Area 

1 Open the top cover. 

CAUTION
Paper jams in this area may result in 
loose toner on the page. If you get any 
toner on your clothes, wash them in cold 
water because hot water will set the 
toner into the fabric.

2 Remove the toner cartridge.

CAUTION
To prevent damage, do not expose the 
toner cartridge to light for more than a 
few minutes. Place a piece of paper over 
the top of the toner cartridge to shield it 
while it is out of the printer.

3 Carefully lift up the registration 
plate. If the leading edge of the 
paper is visible, gently pull the 
paper toward the rear of the printer 
to remove it from the printer.

Continued on next page.

3

1

2
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Note
If the paper is too difficult to remove or 
has already entered the output area, 
remove the jam as described for the 
output areas on page 89.

4 When the jammed paper has been 
removed, gently flip down the 
registration plate. Replace the toner 
cartridge and shut the top cover.

Note
If the toner cartridge is difficult to re-
install, make sure the registration plate 
has been flipped back down into 
position.

If the Attention light does not go out, 
there is still jammed paper inside the 
printer. Check the paper feed or output 
areas.

4
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Paper Jam: Tray 2 or 
Optional Tray 3 Paper Feed 
Area 

Note
If paper has entered the toner cartridge 
area, follow the instructions on page 86. 
It is easier to remove paper from the 
toner cartridge area than the paper feed 
area.

1 Slide out Tray 2 to expose the 
jammed paper. 

2 Remove any misfed paper by 
pulling it out by the visible edge. 
Make sure that all of the paper is 
aligned in the tray. If Tray 3 is 
installed, remove any misfed paper 
and make sure that all of the paper 
is aligned in that tray. 

3 If the paper is jammed in the paper 
feed area and cannot be accessed 
from the toner cartridge area, grasp 
the paper and carefully pull it free 
from the printer. 

4 Push the paper down to lock the 
metal paper lift plate into place and 
slide the tray back into the printer.

Note
If the Attention light does not go out, 
there is still jammed paper inside the 
printer. Check the toner cartridge and 
rear output areas for paper jams.

 

1

2

3

4
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Paper Jam: Output Areas 

CAUTION
Paper jams in this area may result in 
loose toner on the page. If you get any 
toner on your clothes, wash them in cold 
water because hot water will set the 
toner into the fabric.

1 Open the top cover and remove the 
toner cartridge. Open the rear 
output bin.

Note
It is necessary to open the top cover in 
order to release the rear output gearing 
for easy paper removal.

2 If the leading edge of the paper is 
not visible or barely visible in the 
cartridge area, carefully pull the 
leading edge out of the printer from 
the rear output opening using both 
hands. Carefully remove the rest of 
the jammed paper from the printer.

3 If the paper is almost completely 
visible from the top output bin, pull 
the remaining paper carefully out of 
the printer. 

4 Re-install the toner cartridge. 
Close the top cover and the rear 
output bin.

Note
If the Attention light does not go out, 
there is still jammed paper inside the 
printer. Check the paper feed and the 
toner cartridge areas for paper jams.

3

1

2

4
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Paper Jam: Removing Torn 
Pieces of Paper 

Sometimes a piece of jammed paper can 
tear when being removed. Use the 
following procedure to remove any small 
pieces of paper left in the printer.

1 Make sure the toner cartridge is 
installed, the top cover is closed, 
and Tray 2 and optional Tray 3 (if 
installed) are completely pushed 
into the printer.

2 Turn the printer off and then back 
on. As the printer restarts, the 
rollers will advance the piece(s) of 
paper.

3 Open the top cover and remove the 
toner cartridge. Open the rear 
output bin.

4 Remove the piece(s) of paper. 

If the paper cannot be removed by hand, 
repeat steps 1 through 4. Reinstall the 
toner cartridge when all the paper has 
been removed. Close the top cover and 
the rear output bin.

1

2

3

4
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Solving Print Quality Problems 

Print Quality Checklist 
General print quality problems can be solved by following the 
checklist below. 

l Check the printer driver to make sure you are using the best 
available print quality option (see page 58).

l Redistribute the toner in the toner cartridge (see page 71).

l Clean the inside of the printer (see page 73).

l Check the paper type and quality (see page 139).

l Adjust the print density from the software (see page 58).

l Check to make sure EconoMode is off in the software (see page 
56).

l Troubleshooting General Printing Problems (see page 80). 

l Install a new HP toner cartridge, then check print quality again. 
See instructions provided with the toner cartridge.
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Image Defect Examples 
The examples below depict letter-size paper that has passed through 
the printer short-edge first. The following pages list the typical cause 
and solution for each of these examples.

Light Print or 
Fade

Vertical Repetitive 
Defects

Misformed 
Characters

Vertical Lines

Toner SmearGray 
Background

Dropouts

Page Skew

Toner Specks

Curl or Wave Wrinkles or 
Creases

Loose Toner
92  Chapter 4 Problem Solving EN
Download from Www.Somanuals.com. All Manuals Search And Download.



Light Print or Fade

If a vertical white streak or faded area appears on the page:

l The toner supply is low. You may be able to temporarily extend 
the toner cartridge life. See “Redistributing the Toner” on page 71. 
If this does not improve the print quality, install a new HP toner 
cartridge.

l The paper may not meet HP’s paper specifications (for example, 
the paper is too moist or too rough). See “Media Specifications” 
on page 139.

l If the whole page is light, the print density adjustment is too light 
or EconoMode may be on. Adjust the print density and 
EconoMode within the software driver. See “Using EconoMode” 
on page 56.

l A combination of faded and smeared defects may indicate that 
the cartridge needs cleaning. See “Toner Cartridge Cleaning” on 
page 73.

Toner Specks
l The paper may not meet HP’s paper specifications (for example, 

the paper is too moist or too rough). See “Media Specifications” 
on page 139.

l The transfer roller may be dirty. See “Internal Cleaning 
Procedure” on page 75.

l The paper path may need cleaning. See “Engine Cleaning” on 
page 73.

Dropouts 

If faded areas, generally rounded, occur randomly on the page:

l A single sheet of paper may be defective. Try reprinting the job.

l The moisture content of the paper is uneven or the paper has 
moist spots on its surface. Try paper from a different source. See 
“Media Specifications” on page 139.

l The paper lot is bad. The manufacturing processes can cause 
some areas to reject toner. Try a different kind or brand of paper. 
See “Media Specifications” on page 139.

l The toner cartridge may be defective. See “Vertical Repetitive 
Defects” on page 95.

l If these steps do not correct the problem, contact an HP- 
authorized dealer or service representative.
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Vertical Lines 

If black or white vertical streaks appear on the page:

l The photosensitive drum inside the toner cartridge has probably 
been scratched. Install a new HP toner cartridge.

Gray Background 

If the amount of background toner shading becomes unacceptable, 
the procedures described below may help to clear the condition:

l Decrease the density setting. This will decrease the amount of 
background shading.

l Change the paper to a lighter basis weight. See “Media 
Specifications” on page 139.

l Check the printer’s environment; very dry (low humidity) 
conditions can increase the amount of background shading.

l Install a new HP toner cartridge.

Toner Smear 
l If toner smears appear on the leading edge of the paper, the 

paper guides are dirty. See “Internal Cleaning Procedure” on 
page 75.

l A combination of faded and smeared defects may indicate that 
the cartridge needs cleaning. See “Toner Cartridge Cleaning” on 
page 73.

l Check the paper type and quality. See “Media Specifications” on 
page 139.

l Try installing a new HP toner cartridge.

Loose Toner
l Clean the inside of the printer. See “Internal Cleaning Procedure” 

on page 75.

l Check the paper type and quality. See “Media Specifications” on 
page 139.

l Try installing a new HP toner cartridge.
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Vertical Repetitive Defects 

If marks repeatedly appear on the printed side of the page at even 
intervals:

l The toner cartridge may be damaged. The circumference of the 
toner cartridge drum is 94 mm (3.7 in.). If a repetitive mark occurs 
every 94 mm (3.7 in.) on the page, install a new HP toner 
cartridge.

l Internal parts may have toner on them. If the defects occur on the 
back of the page, the problem will likely correct itself after a few 
more pages.

l The fusing assembly may be damaged. Contact an HP-approved 
service technician.

Misformed Characters 
l If characters are improperly formed, producing hollow images, the 

paper stock may be too slick. Try a different paper. See “Media 
Specifications” on page 139.

l If characters are improperly formed, producing a wavy effect, the 
laser scanner may need service. Verify that it also occurs on a 
demo page by pressing GO when the printer is ready. If you need 
service, contact an HP-authorized dealer or service 
representative. See “Hewlett-Packard Limited Warranty 
Statement” on page 121.

Page Skew
l Check the paper type and quality. See “Media Specifications” on 

page 139.

l Make sure the paper or other media is loaded correctly and that 
the guides are not too tight or too loose against the paper stack.

Curl or Wave
l Check the paper type and quality. Both high temperature and 

humidity will cause paper curl. See “Media Specifications” on 
page 139.

l Turn over the stack of paper in the tray. Also try rotating the paper 
180° in the input tray.

l Open the rear door and try printing to the rear output bin. 
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Wrinkles or Creases
l Make sure that paper is loaded properly.

l Check the paper type and quality. See “Media Specifications” on 
page 139.

l Open the rear door and try printing to the rear output bin. 

l Turn over the stack of paper in the tray or try rotating the paper 
180° in the input tray.

Hint If the page is totally blank (all white) check to make sure the sealing 
tape is removed from the toner cartridge and ensure that the toner 
cartridge is installed correctly.
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Infrared Printing Problems

Infrared Printing Problems

Symptom Possible Cause Solution

The connection cannot be 
established or the 
transmission seems to be 
taking longer than usual.

Computer is not IrDA-
compliant.

Make sure the computer you 
are using is IrDA-compliant; 
look for an IrDA symbol on the 
device or refer to the 
computer’s manual. 

IR Driver is not installed on 
your computer or Personal 
Digital Assistant (PDA).

Make sure the operating 
system on the computer 
includes an IR driver and your 
application is using an HP 
LaserJet 2100 series printer 
driver. Keep in mind that 
complex pages take longer to 
print.

HP does not supply the IR 
driver for the computer port. 
The IR driver is available 
through the hardware or 
operating system 
manufacturers. Contact your 
hardware or software tech 
support to obtain a driver.

Computer and printer are not 
positioned properly.

Make sure you have 
positioned the device within 
the range of operation and that 
no objects, such as a finger, 
paper, books, or bright light 
are interfering with the 
connection. Also make sure 
the two IR ports are clean 
(free from dirt and grease).
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The connection cannot be 
established or the 
transmission seems to be 
taking longer than usual 
(continued).

Bright lights are interfering 
with the signal.

Make sure that no bright light 
is shining directly into either IR 
port. Bright light of any kind 
(sunlight, incandescent light, 
fluorescent light, or light from 
an infrared remote control, 
such as those used for TVs 
and VCRs) shining directly into 
one of the IR ports may cause 
interference. Position the 
device closer to the IR port on 
the printer.

The printer prints only part of a 
page or document.

The connection has been 
interrupted during 
transmission.

IrDA-compliant devices are 
designed to recover from 
temporary connection 
interruptions. Re-establish the 
connection. (Depending on the 
device you are using, it can 
take anywhere from 3 to 40 
seconds to re-establish the 
connection.)

The print job has been 
properly sent to the printer, but 
the printer will not print.

The connection may have 
been disrupted or broken.

If the connection is broken 
before the print job has 
started, the printer may not 
print any of the job. If the Data 
(middle) light is on, press JOB 
CANCEL to clear the printer 
memory. Position the device 
within the range of operation 
and print the job again.

The IR status light turns off 
during transmission.

The connection may have 
been broken.

If the Data (middle) light is on, 
press JOB CANCEL to clear the 
printer memory. Position the 
device within the range of 
operation and print the job 
again.

Infrared Printing Problems (continued)

Symptom Possible Cause Solution
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Troubleshooting Error Messages 

When the printer experiences an error, the control panel will indicate 
the error message by five light patterns. Find the light pattern below 
that matches the printer light pattern and follow the recommendations 
to troubleshoot the error. Some error messages will signal a 
secondary light message that will indicate what type of error is 
occurring. See “Secondary Light Patterns” on page 102.

Note Common status light patterns are described on page 16.

Paper Out

The printer is out of paper in the requested tray. Filling the trays with 
paper will cancel this message and allow you to continue with the 
print job.

Continuable
Error

Attention Service
Error

Accessory
 Error

OnOff Blinking

Paper Out
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Attention

There are three possible causes that will display the Attention light 
pattern:

l Door open

l Toner cartridge missing

l Paper jam

After the cause of the problem has been addressed, pressing the GO 
button will cause the printer to attempt to recover from the cause of 
the error. If there is a paper jam, the printer will attempt to clear the 
jam. If the printer is unsuccessful, it will continue to display the 
Attention message until the cause is remedied.

Pressing the JOB CANCEL button will cancel the print job and the 
printer will return to Ready unless there is a paper jam still in the 
printer. See “Clearing Paper Jams” on page 85.

Continuable Error

An error has occurred that has caused the printer to halt the current 
print job. Pressing the GO button causes the printer to attempt to 
recover from the error and print whatever data it can. If the attempt to 
recover from the error is successful, the Ready light will blink while 
the printer completes the job. If the printer cannot recover, it will 
display the Continuable Error message.

Pressing the JOB CANCEL button will cancel the print job and the 
printer will return to ready if the cause of the error has been fixed.

Pressing the GO and JOB CANCEL buttons simultaneously and then 
releasing the buttons will cause the printer to display a secondary 
light pattern that will indicate the error code corresponding to the 
current error condition. See “Continuable Error” on page 102.
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Service Error

An error has occurred that has caused the printer to halt the current 
print job. Pressing the GO button or the JOB CANCEL button with this 
message has no effect.

To clear the error, turn the printer off and then on again. If the problem 
persists, leave the printer off for 15 minutes to reset the formatter. If 
the problem continues, contact HP Service.

Accessory Error

An error has occurred with one of the accessories, either the EIO port 
or the DIMM slots, that has caused the printer to halt the current print 
job. Pressing the GO button or the JOB CANCEL button with this 
message has no effect.

Pressing the GO and JOB CANCEL buttons simultaneously and then 
releasing the buttons will cause the printer to display a secondary 
light pattern that will indicate the error code corresponding to the 
current error condition. See “Accessory Error” on page 105.
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Secondary Light Patterns

Continuable Error

Type of Error Light Pattern Recommended Action

Memory Overflow The printer memory is full.
Press Go to resume printing. If you lose 
some data, try to free some printer 
memory by removing any unnecessary 
fonts, macros, or any data currently in 
printer memory. If you continue to lose 
data, you may need to add more printer 
memory. For a temporary solution, 
simplify the image or print at a 600-dpi 
resolution.

Temporary Engine 
Error

The printer has experienced a temporary 
engine error. Reset the printer by briefly 
turning the printer off and back on again. 

Print Overrun The print job was too complex for 
available printer memory.
Press Go to resume printing. If you lose 
some data, you may need to add more 
printer memory. For a temporary 
solution, simplify the image or print at a 
600-dpi resolution.
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IO Error The cable between the printer and 
computer has a bad connection or the 
cable is of poor quality. Check the cable 
connections to see if they are secure. 
Make sure you are using a high-quality 
cable.

Temporary Error The printer has experienced a temporary 
error. Reset the printer by briefly turning 
the printer off and back on again.

NVRAM Error The nonvolatile memory (NVRAM) is 
temporarily full.
Press Go to clear the message. Check 
the printer settings to ensure they are 
correct. If the problem persists, contact 
your dealer or HP service representative.

Continuable Error (continued)

Type of Error Light Pattern Recommended Action
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EIO Error The printer has experienced a temporary 
EIO error. Reset the printer by turning 
the printer off and back on again.

Continuable Error (continued)

Type of Error Light Pattern Recommended Action
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Accessory Error

Type of Error Light Pattern Recommended Action

EIO Port Error Remove the accessory from the 
EIO Port or DIMM Slot indicated by 
the error to continue printing.

DIMM Slot 1 Error Remove the accessory from the 
EIO Port or DIMM Slot indicated by 
the error to continue printing.

DIMM Slot 2 Error Remove the accessory from the 
EIO Port or DIMM Slot indicated by 
the error to continue printing.
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DIMM Slot 3 Error Remove the accessory from the 
EIO Port or DIMM Slot indicated by 
the error to continue printing.

Accessory Error (continued)

Type of Error Light Pattern Recommended Action
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Network Problems 

You are experiencing shared printer problems.

l Print a Configuration page. If an HP JetDirect EIO print server is 
installed, printing a Configuration page will also print a second 
page that will show the network settings and status.

l Try printing the job from another computer.

l To verify if a printer works with a computer, connect it directly to a 
computer with a parallel cable. Print a document from an 
application that has printed correctly in the past. If this works, 
then there may be a problem with the network.

l Contact your network administrator for assistance.
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Common Windows Problems

Common Windows Problems

Symptom Possible Cause Solution

Windows message during 
installation reads: “File in 
Use.”

Quit all software. Remove all software 
from the StartUp Group, then restart 
Windows. Reinstall the printer drivers.

Error Message:
“Error Writing to LPTx” in 
Windows 9x. 

Make sure the cables are connected 
correctly, the printer is on, and the 
Ready (front) light is on.

If bi-directional communication is not 
turned on in the driver, it will also 
cause this message.

Click on Start, Settings, Printers. 
Right click on the HP LaserJet 2100 
driver and select Properties. Click on 
Details, Port Settings. Remove check 
from “Check Port State before 
Printing” box. Click OK. Click on 
Spool Settings. Select “Print Directly 
to Printer.” Click OK. 
Try printing again.

Error Message:
“General Protection Fault”
“Exception OE”
“Spool32”
“Illegal Operation”

Close all other applications, reboot 
Windows, and try again.

Switch the printer driver. If the 
HP LaserJet 2100 Series PCL 6 
Driver is selected, switch to another 
printer driver such as an HP LaserJet 
2100 Series PCL 5e Driver or a 
Microsoft Driver.
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Error Message:
“General Protection Fault”
“Exception OE”
“Spool32”
“Illegal Operation”
(Continued)

Delete all temp files from the Temp 
sub-directory. You can determine the 
name of the directory by editing the 
AUTOEXEC.BAT file and looking for 
the statement “Set Temp = .” The 
name after this statement is the temp 
directory. It is usually C:\temp  by 
default, but can be redefined.

Refer to Microsoft Windows 3.x, 9x, or 
NT 4.0 documentation that came with 
your PC for further information on 
Windows error messages.

Common Windows Problems (continued)

Symptom Possible Cause Solution
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Common Macintosh Problems 

Macintosh Problems

Symptom Possible Cause Solution

Problems in the Chooser

Printer driver icon does not 
appear in the Chooser.

Software not installed 
correctly.

The LaserWriter driver should be 
present as a part of the Mac OS. 
Make sure that the LaserWriter driver 
is in the Extensions folder within the 
systems folder. If not, install the 
LaserWriter driver component from 
the installation CD.

Make sure you are using a high-
quality cable.

Make sure the printer is on the correct 
network. Select the Network or 
AppleTalk Control Panel from Control 
Panels in the Apple menu and then 
choose the correct network.

Printer name does not 
appear in the “Select a 
PostScript Printer” box in 
the Chooser.

Make sure the cables are connected 
correctly, the printer is on, and the 
Ready (front) light is on.

Make sure the correct printer driver 
has been selected in the Chooser.

If the printer resides on a network with 
multiple zones, make sure the correct 
zone is selected in the “AppleTalk 
Zones” box in the Chooser.
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Make sure the printer has been 
chosen in the Chooser by printing a 
self-test. (Simultaneously press GO 
and JOB CANCEL.) Check the 
AppleTalk name of the printer 
displayed on the self-test page.

Make sure AppleTalk is on. (The 
button next to Active is selected in the 
Chooser.) You may need to restart the 
computer to activate the change.

The printer driver does not 
automatically set up your 
selected printer even 
though you clicked Auto 
Setup in the Chooser.

Reinstall the printer software. See 
“Macintosh Installation” on page 10.

Select an alternate PPD. 

Printing Errors 

A print job was not sent to 
your desired printer.

Another printer with the 
same or similar name 
may have received your 
print job. 

Rename the printer using the 
HP LaserJet Utility, making sure that 
all devices have unique names. 

You cannot use the 
computer while the printer 
is printing.

Background Printing has 
not been selected.

LaserWriter 8.3

Turn Background Printing on in the 
Chooser. Status messages will now 
be redirected to the Print Monitor 
allowing you to continue working 
while the computer is processing data 
to be sent to the printer.

LaserWriter 8.4 and higher

Turn Background Printing on by 
selecting File, Print Desktop, and 
Background Printing.

Macintosh Problems (continued)

Symptom Possible Cause Solution
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An encapsulated 
PostScript (EPS) file does 
not print with the correct 
fonts. 

This problem occurs with 
some software 
applications. 

Try downloading the fonts contained 
in the EPS file to the printer before 
printing.

Your document is not 
printing with New York, 
Geneva, or Monaco. 

Select Options in the Page Setup 
dialog box to deselect substituted 
fonts.

Macintosh Problems (continued)

Symptom Possible Cause Solution
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Selecting an Alternate PPD
1. Open the Chooser from the Apple menu. 

2. Click the LaserWriter icon.

3. If you are on a network with multiple zones, select the zone in the 
AppleTalk Zones box where the printer is located.

4. Click the printer name you want to use in the Select a PostScript 
Printer box. (Double-clicking will immediately generate the next 
few steps.)

5. Click Setup... (This button may read Create for first-time setup.)

6. Click Select PPD....

7. Find the desired PPD in the list and click Select. If the desired 
PPD is not listed, choose one of the following options:

• Select a PPD for a printer with similar features.

• Select a PPD from another folder.

• Select the generic PPD by clicking Use Generic. The generic 
PPD allows you to print, but limits your access to printer 
features.

8. In the Setup dialog box, click Select, and then click OK to return 
to the Chooser.

Note If you manually select a PPD, an icon might not appear next to the 
selected printer in the Select a PostScript Printer box. In the Chooser, 
click Setup, click Printer Info, and then click Update Info to bring up the 
icon.

9. Close the Chooser.

Renaming the Printer

If you are going to rename the printer, do this before selecting the 
printer in the Chooser. If you rename the printer after selecting it in 
the Chooser, you will have to go back into the Chooser and reselect it.

Use the Set Printer Name feature in the HP LaserJet Utility to rename 
the printer. 
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Troubleshooting PS Errors 

The following situations are PS language specific and may occur 
when several printer languages are being used.

Note To receive a printed or screen displayed message when PS errors 
occur, open the Print Options dialog box and click the desired selection 
next to the PS Errors section.

PS Errors

Symptom Possible Cause Solution

The job prints in Courier (the 
printer’s default typeface) 
instead of the typeface you 
requested.

The requested typeface is not 
downloaded. A personality 
switch may have been 
performed to print a PCL job 
just before the PS printing job 
was received.

Download the desired font and 
send the print job again. Verify 
the type and location of the 
font. Download to printer if 
applicable. Check with the 
software documentation.

A legal page prints with 
clipped margins. 

Print job too complex. You may need to print your job 
at 600 dots per inch, reduce 
the complexity of the page, or 
install more memory. 

A PS error page prints. Print job may not be PS. Make sure the print job is a PS 
job. Check to see whether the 
software application expected 
a setup or PS header file to be 
sent to the printer.

Specific Errors

Limit Check Error Print job too complex. You may need to print your job 
at 600 dots per inch, reduce 
the complexity of the page, or 
install more memory. 
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VM Error Font Error Select unlimited 
downloadable fonts from 
printer driver.

Range Check Font Error Select unlimited 
downloadable fonts from 
printer driver.

PS Errors (continued)

Symptom Possible Cause Solution
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5 Service and Support

Availability

HP provides a variety of service and support options around the 
world. Availability of these programs will vary depending upon your 
location.

HP Express Exchange

1. The customer contacts the local HP Customer Support Center 
listed in the product documentation. A technician troubleshoots 
the situation and determines whether the printer has actually 
failed. If so, the technician refers the customer to the HP Service 
Center. 

2. A representative from the service center requests product and 
customer information. In some regions, collateral may also be 
requested. 

3. HP ships a refurbished replacement unit to arrive the next day. 
(Geographic distance might prevent next-day shipping.) 

4. The customer sends the defective printer to Hewlett-Packard at 
HP's expense. 

Customers with on-site support service provided by HP should work 
directly with the local Customer Support Center instead of following 
the steps outlined here.

Exchanged units carry the remainder of the original unit’s warranty or 
90 days, whichever is greater. The faster turnaround from HP Express 
Exchange minimizes downtime over traditional service programs that 
require you to ship the failed unit to the manufacturer, and then wait 
for it to be repaired and returned. Because HP pays the shipping 
charges, you incur no hidden costs for the service.
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Guidelines for Repacking the Printer

! Remove and retain any DIMMs (dual in-line memory modules) 
installed in the printer.

! Remove and retain any cables and optional accessories installed 
in the printer.

CAUTION Static electricity can damage DIMMs. When handling DIMMs, either 
wear an antistatic wrist strap or frequently touch the surface of the 
DIMMs’ antistatic package, then touch bare metal on the printer. To 
remove the DIMMs see “Installing Memory” on page 153.

! Remove and retain the toner cartridge.

CAUTION To prevent damage to the toner cartridge, store the cartridge in its 
original packing material, or store it so that it is not exposed to light.

! Use the original shipping container and packing material, if 
possible. (Shipping damage as a result of inadequate packing is 
the customer’s responsibility.) If you have already disposed of the 
printer’s packing material, contact a local mailing service for 
information on repacking the printer. 

! If possible, include print samples and 50-100 sheets of paper or 
other media that did not print correctly.

! Include a completed copy of the Service Information Form on 
page 119.

! HP recommends insuring the equipment for shipment.
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Service Information Form

WHO IS RETURNING THE EQUIPMENT? Date:

Person to contact: Phone: (     )

Alternate contact: Phone: (     )

Return shipping address: Special shipping instructions:

WHAT IS BEING SENT?

Model name: Model number: Serial number:

Please attach any relevant printouts when returning equipment. DO NOT ship accessories (manuals, cleaning supplies, 
etc.) that are not required to complete the repair.

WHAT NEEDS TO BE DONE?   (Attach a separate sheet if necessary.)

1. Describe the conditions of the failure. (What was the failure? What were you doing when the 
failure occurred? What software were you running? Is the failure repeatable?)

2. If the failure is intermittent, how much time elapses between failures?

3. Is the unit connected to any of the following? (Give manufacturer and model number.)

Personal computer: Modem: Network:

4. Additional comments:

HOW WILL YOU PAY FOR THE REPAIR?

" Under warranty Purchase/received date: ____________________________
(Enclose proof of purchase or receiving document with original received date.)

" Maintenance contract number: ______________________

" Purchase order number: ___________________________

Except for contract and warranty service, a purchase order number and/or authorized 
signature must accompany any request for service. If standard repair prices do not apply, 
a minimum purchase order is required. Standard repair prices can be obtained by contacting 
an HP-authorized Repair Center.

Authorized signature: ______________________________ Phone: ________________

Billing address: Special billing instructions:
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HP Maintenance Agreements

HP has several types of maintenance agreements that meet a wide 
range of support needs. Maintenance agreements are not part of the 
standard warranty. Support services vary by area. Check with your 
local HP dealer to determine the services available to you.

On-Site Service Agreements
To provide you with the level of support best suited to your needs, HP 
has on-site service agreements with three response times:

Priority On-Site Service

This agreement provides 4-hour service response to your site for calls 
made during normal HP business hours.

Next-Day On-Site Service

This agreement provides support by the next working day following a 
service request. Extended coverage hours and extended travel 
beyond HP’s designated service zones are available on most on-site 
agreements (for additional charges).

Weekly (Volume) On-Site Service

This agreement provides scheduled weekly on-site visits for 
organizations with many HP products. This agreement is designated 
for sites using 25 or more workstation products, including printers, 
plotters, computers, and disk drives.
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Hewlett-Packard Limited Warranty Statement

1. HP warrants to you, the end-user customer, that HP hardware, accessories, and 
supplies, will be free from defects in materials and workmanship after the date of 
purchase, for the period specified above. If HP receives notice of such defects 
during the warranty period, HP will, at its option, either repair or replace products 
which prove to be defective. Replacement products may be either new or like-new.

2. HP warrants to you that HP software will not fail to execute its programming 
instructions after the date of purchase, for the period specified above, due to 
defects in material and workmanship when properly installed and used. If HP 
receives notice of such defects during the warranty period, HP will replace 
software media which does not execute its programming instructions due to such 
defects.

3. HP does not warrant that the operation of HP products will be uninterrupted or 
error free. If HP is unable, within a reasonable time, to repair or replace any 
product to a condition as warranted, you will be entitled to a refund of the 
purchase price upon prompt return of the product.

4. HP products may contain remanufactured parts equivalent to a new in 
performance or may have been subject to incidental use.

5. Warranty does not apply to defects resulting from (a) improper or inadequate 
maintenance or calibration, (b) software, interfacing, parts or supplies not supplied 
by HP, (c) unauthorized modification or misuse, (d) operation outside of the 
published environmental specifications for the product, or (e) improper site 
preparation or maintenance.

6. HP MAKES NO OTHER EXPRESS WARRANTY OR CONDITION WHETHER 
WRITTEN OR ORAL. TO THE EXTENT ALLOWED BY LOCAL LAW, ANY 
IMPLIED WARRANTY OR CONDITION OR MERCHANTABILITY, 
SATISFACTORY QUALITY, OR FITNESS FOR A PARTICULAR PURPOSE IS 
LIMITED TO THE DURATION OF THE EXPRESS WARRANTY SET FORTH 
ABOVE. Some countries, states or provinces do not allow limitations on the 
duration of an implied warranty, so the above limitation or exclusion might not 
apply to you. This warranty gives you specific legal rights and you might also have 
other rights that vary from country to country, state to state, or province to 
province.

HP PRODUCT DURATION OF WARRANTY

HP LaserJet 2100, 2100 M, 2100 TN 1 year, Return to Authorized 
Service Center
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7. TO THE EXTENT ALLOWED BY LOCAL LAW, THE REMEDIES IN THIS 
WARRANTY STATEMENT ARE YOUR SOLE AND EXCLUSIVE REMEDIES. 
EXCEPT AS INDICATED ABOVE, IN NO EVENT WILL HP OR ITS SUPPLIERS 
BE LIABLE FOR LOSS OF DATA OR FOR DIRECT, SPECIAL, INCIDENTAL, 
CONSEQUENTIAL (INCLUDING LOST PROFIT OR DATA), OR OTHER 
DAMAGE, WHETHER BASED IN CONTRACT, TORT, OR OTHERWISE. Some 
countries, states or provinces do not allow the exclusion or limitation of incidental 
or consequential damages, so the above limitation or exclusion may not apply to 
you.

8. FOR CONSUMER TRANSACTIONS IN AUSTRALIA AND NEW ZEALAND; THE 
WARRANTY TERMS CONTAINED IN THIS STATEMENT, EXCEPT TO THE 
EXTENT LAWFULLY PERMITTED, DO NOT EXCLUDE, RESTRICT OR MODIFY 
AND ARE IN ADDITION TO THE MANDATORY STATUTORY RIGHTS 
APPLICABLE TO THE SALE OF THIS PRODUCT TO YOU.
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Limited Warranty for Toner Cartridge Life

Note The warranty below applies to the toner cartridge that came with this 
printer. 

HP toner cartridges are warranted to be free from defects in materials 
and workmanship until the HP toner is depleted. The warranty covers 
any defects or malfunctions in a new Hewlett-Packard toner cartridge.

How long does the coverage last?
The coverage lasts until the HP toner is depleted, at which time the warranty 
expires.
How do I know when the HP toner is running out?
The HP toner is depleted when faded or light type appears on the printed 
page.
What will HP do?
HP will, at HP’s option, either replace products which prove to be defective or 
refund the purchase price. If possible, please attach a printout sample 
illustrating what the defective cartridge is printing.
What does this warranty not cover?
The warranty does not cover cartridges which have been refilled, are 
emptied, are abused, are misused, or are tampered with in any way.
How do I return the faulty cartridge?
In the event the cartridge proves to be defective, complete the Service 
Information Form and attach a print sample illustrating the defect. Return the 
form and cartridge to the place of purchase, where the cartridge will be 
replaced.
How does State, Province or Country Law apply?
This limited warranty gives you specific legal rights, and you may also have 
other rights which vary from state to state, province to province, or country to 
country. This limited warranty is the sole warranty on the HP toner cartridge 
and supersedes any other warranty relating to this product.

FOR CONSUMER TRANSACTIONS IN AUSTRALIA AND NEW ZEALAND; 
THE WARRANTY TERMS CONTAINED IN THIS STATEMENT, EXCEPT TO 
THE EXTENT LAWFULLY PERMITTED, DO NOT EXCLUDE, RESTRICT OR 
MODIFY AND ARE IN ADDITION TO THE MANDATORY STATUTORY 
RIGHTS APPLICABLE TO THE SALE OF THIS PRODUCT TO YOU.

IN NO EVENT SHALL HEWLETT-PACKARD COMPANY BE LIABLE FOR 
ANY INCIDENTAL, CONSEQUENTIAL, SPECIAL, INDIRECT, PUNITIVE, 
OR EXEMPLARY DAMAGES OR LOST PROFITS FROM ANY BREACH OF 
THIS WARRANTY OR OTHERWISE.
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Worldwide Sales and Service Offices

Note Before calling an HP Sales and Service office, be sure to contact the 
appropriate Customer Support Center number listed in the 
“HP Support” section. Products should not be returned to these offices. 
Product return information is also available through the appropriate 
Customer Support Center in “HP Support” in the front of this guide.

Argentina
Hewlett-Packard Argentina S.A.
Montañeses 2140/50/60
1428 Buenos Aires
Phone: (54) (1) 787-7100
Fax: (54) (1) 787-7213

Australia
Hewlett-Packard Australia Ltd.
31-41 Joseph Street
Blackburn, VIC 3130
Phone: (61) (3) 272-2895
Fax: (61) (3) 898-7831
Hardware Repair Center:
Phone: (61) (3) 272-8000
Extended Warranty Support:
Phone: (61) (3) 272-2577
Customer Information Center:
Phone: (61) (3) 272-8000

Austria
Hewlett-Packard GmbH
Lieblgasse 1
A-1222 Vienna
Phone: (43) (1) 25000-555
Fax: (43) (1) 25000-500

Belgium
Hewlett-Packard Belgium S.A. NV
Boulevard de la Woluwe-Woluwedal 
100-102
B-1200 Brussels
Phone: (32) (2) 778-31-11
Fax: (32) (2) 763-06-13

Brazil
Edisa Hewlett-Packard SA
Alameda Rio Negro 750
06454-050 Alphaville - Barueri-SP
Phone:  (55) (11)- 7296-8000

Canada
Hewlett-Packard (Canada) Ltd.
17500 Trans Canada Highway
South Service Road
Kirkland, Québec H9J 2X8
Phone: (1) (514) 697-4232
Fax: (1) (514) 697-6941

Hewlett-Packard (Canada) Ltd.
5150 Spectrum Way
Mississauga, Ontario L4W 5G1
Phone: (1) (905) 206-4725
Fax: (1) (905) 206-4739

Chile
Hewlett-Packard de Chile
Avenida Andres Bello 2777 of. 1
Los Condes
Santiago, Chile

China
China Hewlett-Packard Co. Ltd.
Level 5, West Wing Office
China World Trade Center
No. 1, Jian Guo Men Wai Avenue
Beijing 100004
Phone: (86) (10) 6505-3888,x. 5450
Fax: (86) (10) 6505-1033
Hardware Repair Center and Extended 
Warranty Support:
Phone: (86) (10) 6262-5666x. 6101/2

(86) (10) 6261-4167
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Colombia
Hewlett-Packard Colombia
Calle 100 No. 8A -55
Torre C Oficina 309
Bogotá, Colombia

Czech Republic
Hewlett-Packard s. r. o.
Novodvorská 82
CZ-14200 Praha 4
Phone: (42) (2) 613-07111
Fax: (42) (2) 471-7611

Denmark
Hewlett-Packard A/S
Kongevejen 25
DK-3460 Birkerød
Denmark
Phone: (45)3929 4099
Fax: (45) 4281-5810

Far East Region
Hewlett-Packard Asia Pacific Ltd.
17-21/F Shell Tower, Times Square
1 Matheson Street, Causeway Bay
Hong Kong 
Phone: (852) 2599-7777
Fax: (852) 2506-9261
Hardware Repair Center:
Phone: (852) 2599-7000
Extended Warranty Support:
Phone: (852) 2599-7000
Customer Information Center:
Phone: (852) 2599-7066

Finland
Hewlett-Packard Oy
Piispankalliontie 17
FIN-02200 Espoo
Phone: (358) (9) 887-21
Fax: (358) (9) 887-2477

France
Hewlett-Packard France
42 Quai du Point du Jour
F-92659 Boulogne Cedex
Phone: (33) (146) 10-1700
Fax: (33) (146) 10-1705

Germany
Hewlett-Packard GmbH
Herrenberger Straße 130
71034 Böblingen
Phone: (49) (180) 532-6222

(49) (180) 525-8143
Fax: (49) (180) 531-6122

Greece
Hewlett-Packard Hellas
62, Kifissias Avenue
GR-15125 Maroussi
Phone: (30) (1) 689-6411
Fax: (30) (1) 689-6508

Hungary
Hewlett-Packard Magyarország Kft.
Erzsébet királyné útja 1/c. 
H-1146 Budapest
Phone: (36) (1) 343-0550
Fax: (36) (1) 122-3692
Hardware Repair Center:
Phone: (36) (1) 343-0312
Customer Information Center:
Phone: (36) (1) 343-0310

India
Hewlett-Packard India Ltd.
Paharpur Business Centre
21 Nehru Place
New Delhi 110 019
Phone: (91) (11) 647-2311
Fax: (91) (11) 646-1117
Hardware Repair Center and Extended 
Warranty Support:
Phone: (91) (11) 642-5073

(91) (11) 682-6042

Italy
Hewlett-Packard Italiana SpA
Via Giuseppe di Vittorio, 9
Cernusco Sul Naviglio
I-20063 (Milano)
Phone: (39) (2) 921-21
Fax: (39) (2) 921-04473
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Japan
Hewlett-Packard Japan, Ltd.
3-29-21 Takaido-higashi 
Suginami-ku, Tokyo 168 
Phone: (81) (3) 3335-8333
Fax: (81) (3) 3335-8338
Hardware Repair Center:
Phone: (81) (4) 7355-6660
Fax: (81) (4) 7352-1848

Korea
Hewlett-Packard Korea
25-12, 
Yoido-dong, Youngdeungpo-ku
Seoul 150-010
Phone: (82) (2) 769-0114
Fax: (82) (2) 784-7084
Hardware Repair Center: 
Phone: (82) (2) 3270-0700

(82) (2) 707-2174 (DeskJet)

(82) (2) 3270-0710 (Hardware)

Extended Warranty Support:
Phone: (82) (2) 3770-0365 (Bench)

(82) (2) 769-0500 (Onsite)

Latin American
Headquarters
5200 Blue Lagoon Drive Suite 950
Miami, FL 33126,USA
Phone: (1) (305) 267-4220

México
Hewlett-Packard de México, S.A. de C.V.
Prolongación Reforma No. 700
Lomas de Santa Fe
01210 México, D.F.
Phone: 01-800-22147 
Outside Mexico City
Phone: 01 800-90529

Middle East/Africa
ISB HP Response Center
Hewlett-Packard S.A.
Rue de Veyrot 39
P.O. Box 364
CH-1217 Meyrin - Geneva
Switzerland
Phone: (41) (22) 780-4111

Netherlands
Hewlett-Packard Nederland 
BV Startbaan 16
NL-1187 XR Amstelveen
Postbox 667
NL-1180 AR Amstelveen
Phone: (31) (020) 606-87-51
Fax: (31) (020) 547-7755

New Zealand
Hewlett-Packard (NZ) Limited
Ports of Auckland Building
Princes Wharf, Quay Street
P.O. Box 3860
Auckland
Phone: (64) (9) 356-6640
Fax: (64) (9) 356-6620
Hardware Repair Center and Extended 
Warranty Support:
Phone: (64) (9) 0800-733547
Customer Information Center:
Phone: (64) (9) 0800-651651

Norway
Hewlett-Packard Norge A/S
Postboks 60 Skøyen
Drammensveien 169
N-0212 Oslo
Phone: (47) 2273-5600
Fax: (47) 2273-5610

Poland
Hewlett-Packard Polska
Al. Jerozolimskic 181
02-222 Warszawa
Phone: (48-22) 608-7700
Fax: (48-22) 608-7600

Russia
AO Hewlett-Packard
Business Complex Building #2
129223, Moskva, Prospekt Mira VVC
Phone: (7) (95) 928-6885
Fax: (7) (95) 974-7829
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Singapore
Hewlett-Packard Singapore
(Sales) Pte Ltd
450 Alexandra Road
Singapore (119960)
Phone:  (65)275-3888
Fax:  (65)275-6839Hardware Repair 
Center and Customer
Information Center:
Phone: (65) 272-5300
Extended Warranty Support:
Phone: (65) 272-5333

Spain
Hewlett-Packard Española, S.A.
Carretera de la Coruña km 16.500
E-28230 Las Rozas, Madrid
Phone: (34) (1) 626-1600
Fax: (34) (1) 626-1830

Sweden
Hewlett-Packard Sverige AB
Skalholtsgatan 9
S-164 97 Kista
Phone: (46) (8) 444-2000
Fax: (46) (8) 444-2666

Switzerland
Hewlett-Packard (Schweiz) AG
In der Luberzen 29
CH-8902 Urdorf/Zürich
Phone: (41) (084) 880-11-11
Fax: (41) (1) 753-7700
Warranty Support:
0800-55-5353

Taiwan
Hewlett-Packard Taiwan Ltd.
8th Floor
337, Fu-Hsing North Road
Taipei, 10483
Phone: (886)(02)717-0055
FAX : (886)(02)514-0276
Hardware Repair Center, call:
North (886)(02) 717-9673 
Central (886)(04) 327-0153 
South (886)(080)733-733 
Extended Warranty Support Contact:
Phone:  (886)(02) 714-8882

Thailand
Hewlett-Packard (Thailand) Ltd.
23-25/f Vibulthani Tower II
2199 Rama 4 Rd, Klongton
Klintoey, Bangkok 10110
Thailand
Phone: (66) (2) 666-3900-34
Fax: (66) (2) 666-3935-37
Hardware Repair Center and Extended 
Warranty Support Contact:
Phone: (66) (2) 661-3900 ext. 6001/ 6002
Customer Information Center:
Phone: (66) (2) 661-3900 ext. 3211
Fax: (66) (2) 661-3943

Turkey
Hewlett-Packard Company
Bilgisayar Ve ölçüm Sistemleri AS
19 Mayis Caddesi Nova
Baran Plaza Kat: 12
80220 Sisli-Istanbul
Phone: (90) (212) 224-5925
Fax: (90) (212) 224-5939

United Kingdom
Hewlett-Packard Ltd.
Cain Road
Bracknell
Berkshire RG12 1HN
Phone: (44) (134) 436-9222
Fax: (44) (134) 436-3344

Venezuela
Hewlett-Packard de Venezuela S.A.
Los Ruices Norte
3A Transversal
Edificio Segre Caracas 1071
Phone: (58) (2) 239-4244

Fax: (58) (2) 239-3080
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A Specifications

Printer Specifications

HP LaserJet 2100
HP LaserJet 2100 with 
Optional Tray 3

Height 230 mm (9 in.) 309 mm (12.2 in.)

Width 406 mm (15.9 in.) 406 mm (15.9 in.)

Depth (body) 420 mm (16.5 in.) 420 mm (16.5 in.)

Weight (with toner cartridge) 11.5 kg (25.4 lbs) 14.4 kg (31.7 lbs)

Electrical Specifications
100-127V (+/- 10%) 
50/60Hz (+/- 2Hz)

220-240V (+/- 10%) 
50/60 Hz (+/- 2Hz)

Power Consumption (typical 
for HP LaserJet 2100 Series 
Printers)

During printing  225 W 
(average)
During standby 12 W (instant 
power save)
During power save mode 12 W
During off mode 0W

During printing 225 W 
(average)
During standby 14 W (instant 
power save)
During power save mode 14 W
During off mode 0W

Minimum recommended circuit 
capacity

5 Amps 2.5 Amps 
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WARNING! Power requirements are based on the region where the printer is sold. 
Do not convert operating voltages. This may damage the printer and 
void the product warranty. 

Environmental 
Specifications Operating Printing Storage/Standby

Temperature
(printer and toner cartridge) 

15° to 32.5° C
(59° to 89° F)

-20° to 40° C
(-4° to 104° F)

Relative humidity 10% to 80% 10% to 90% 

Acoustic 
Emissions 
(Per ISO 9296)
(HP LaserJet 2100 
at 10 ppm) Operator Position Bystander (1m) Sound Power

Printing LpAm 55dB(A) LpAm 48dB(A) LWAd 6.2 bels(A)

Power Save
In this mode, the printer is essentially quiet.

See “Printer Features” on page 2 for additional performance and features specifications
130  Appendix A Specifications EN

Download from Www.Somanuals.com. All Manuals Search And Download.



FCC Regulations

This equipment has been tested and found to comply with the limits 
for a Class B digital device, pursuant to Part 15 of the FCC rules. 
These limits are designed to provide reasonable protection against 
harmful interference in a residential installation. This equipment 
generates, uses, and can radiate radio frequency energy. If this 
equipment is not installed and used in accordance with the 
instructions, it may cause harmful interference to radio 
communications. However, there is no guarantee that interference will 
not occur in a particular installation; the presence of interference can 
be determined by turning the equipment off and on. If this equipment 
does cause harmful interference to radio or television 
communications, the user is encouraged to try to correct the 
interference by one or more of the following measures:

! Reorient or relocate the receiving antenna.

! Increase distance between equipment and receiver.

! Connect equipment to an outlet on a circuit different from that to 
which the receiver is located.

! Consult your dealer or an experienced radio/television technician.

Note Any changes or modifications to the printer that are not expressly 
approved by HP could void the user’s authority to operate this 
equipment.

Use of a shielded interface cable is required to comply with the Class 
B limits of Part 15 of FCC rules.
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Environmental Product Stewardship Program

Protecting the Environment
Hewlett-Packard Company is committed to providing quality products 
in an environmentally sound manner. This HP LaserJet printer has 
been designed with several attributes to minimize impacts on our 
environment.

This HP LaserJet printer eliminates:

Ozone Production

The printer uses charging rollers in the electrophotographic process 
and therefore generates no appreciable ozone gas (O3). 

This HP LaserJet printer design reduces:

Energy Consumption

Energy usage drops to as little as 12 W while in low-power 
(PowerSave) mode. Not only does this save natural resources, but it 
also saves money without affecting the high performance of this 
printer. This product qualifies for ENERGY STAR. ENERGY STAR is a 
voluntary program established to encourage the development of 
energy-efficient office products. ENERGY STAR is a U.S. registered 
service mark of the U.S. EPA.

As an ENERGY STAR partner, Hewlett-Packard Company has 
determined that this product meets ENERGY STAR Guidelines for 
energy efficiency.

Toner Consumption

EconoMode uses significantly less toner, which may extend the life of 
the toner cartridge.

Paper use

You can request for a number of pages of your document to be 
printed on one page of paper. This N-up printing practice and the 
printer’s manual duplexing feature, two-sided printing, can reduce 
paper usage and the resulting demands on natural resources.
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The design of this HP LaserJet printer facilitates the 
recycling of:

Plastics

Plastic parts have markings according to international standards that 
enhance the ability to identify plastics for recycling purposes at the 
end of the printer’s life.

HP Toner Cartridges

In many countries/regions, this product’s toner cartridge/drum can be 
returned to HP through the HP Planet Partners LaserJet Toner 
Cartridge Recycling Program. This easy to use program is available in 
over 20 countries/regions. Multi-lingual program information and 
instructions are included in every new HP Toner Cartridge box. 

HP Planet Partners LaserJet Toner Cartridge Recycling Program 
Information: Since 1990, the HP LaserJet Toner Cartridge Recycling 
Program has collected more than 12 million used toner cartridges that 
otherwise may have been discarded in the world’s landfills. The HP 
LaserJet toner cartridges go to a collection center and then they are 
bulk shipped to our recycling partners who disassemble the cartridge 
parts for recycling. After a thorough quality inspection, minor parts 
such as nuts, screws, and clips are reclaimed for use in new 
cartridges. Remaining materials are separated and converted into 
raw materials for use by other industries to make a variety of useful 
products. Over 95% by weight of each returned cartridge is reclaimed 
for recycling. For more information in the U.S., call (1) (800) (340-
2445) or visit the HP LaserJet Supplies website at 
http://www.ljsupplies.com/planetpartners/. Non-US customers can 
call the local HP Sales and Service Office for further information 
regarding the HP Planet Partners LaserJet Toner Cartridge Recycling 
Program.

Paper

This printer is suited for the use of recycled papers when the paper 
meets the guidelines outlined in the HP LaserJet Printer Family Paper 
Specifications Guide. See page 25 for ordering information. This 
printer is suitable for the use of recycled paper according to 
DIN 19 309.
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Material Safety Data Sheet
The Toner Cartridge/Drum MSDS can be obtained by contacting the 
HP LaserJet Supplies website at:

http://ljsupplies.com/planetpartners/datasheets.html

If you do not have access to the Internet, call the U.S. HP FIRST (Fax 
Information Retrieval Service Technology) at (1) (800) 231-9300. Use 
Index number 7 for a listing of the Toner Cartridge/Drum 
Material/Chemical Safety Data Sheets. Non-US customers should 
refer to the front of this manual for appropriate phone numbers and 
information.
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Regulatory Statements 

Declaration of Conformity
according to ISO/IEC Guide 22 and EN45014
Manufacturer's Name: Hewlett-Packard Company

Manufacturer's Address: 11311 Chinden Boulevard

Boise, Idaho 83714-1021, USA

declares that the product

Product Name: HP LaserJet 2100, 2100 M, 2100 TN

Model Number: C4170A, C4171A, C4172A, C4793A

Product Options: ALL

conforms to the following Product Specifications:

Safety: IEC 950:1991+A1+A2+A3 / EN 60950:1992+A1+A2+A3

IEC 825-1:1993 / EN 60825-1:1994 Class 1 (Laser/LED)

EMC: CISPR 22:1993+A1 / EN 55022:1994 Class B1

EN 50082-1:1992

IEC 801-2:1991 / prEN 55024-2:1992 - 4 kV CD, 8 kV AD

IEC 801-3:1984 / prEN 55024-3:1991 - 3 V/m

IEC 801-4:1988 / prEN 55024-4:1992 - 0.5 kV Signal Lines

1.0 kV Power Lines

IEC 1000-3-2:1995 / EN61000-3-2:1995

IEC 1000-3-3:1994 / EN61000-3.3:1995

FCC Title 47 CFR, Part 15 Class B2) / ICES-003, Issue 2 / VCCI-21)

AS / NZS 3548:1992 / CISPR 22:1993 Class B1)

Supplementary Information:

The product herewith complies with the requirements of the following Directives and carries the CE-
marking accordingly:

the EMC directive 89/336/EEC

the Low-Voltage Directive 73/23/EEC

The product was tested in a typical configuration with Hewlett-Packard Personal Computer Systems.

This Device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions: 
(1) this device may not cause harmful interference, and (2) this device must accept any interference 
received, including interference that may cause undesired operation.

For Compliance Information ONLY, contact:

Australia Contact: Product Regulations Manager, Hewlett-Packard Australia Ltd., 
31-41 Joseph Street, Blackburn, Victoria 3130, Australia

European Contact: Your Local Hewlett-Packard Sales and Service Office or 
Hewlett-Packard GmbH, Department HQ-TRE / Standards 
Europe, Herrenberger Straße 130, D-71034 Böblingen 
(FAX: +49-7031-14-3143)

USA Contact: Product Regulations Manager, Hewlett-Packard Company, 
PO Box 15 Mail Stop 160, Boise, ID 83707-0015 
(Phone: 208-396-6000)
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Laser Safety Statement
The Center for Devices and Radiological Health (CDRH) of the U.S. 
Food and Drug Administration has implemented regulations for laser 
products manufactured since August 1, 1976. Compliance is 
mandatory for products marketed in the United States. The printer is 
certified as a “Class 1” laser product under the U.S. Department of 
Health and Human Services (DHHS) Radiation Performance 
Standard according to the Radiation Control for Health and Safety Act 
of 1968.

Since radiation emitted inside the printer is completely confined within 
protective housings and external covers, the laser beam cannot 
escape during any phase of normal user operation. 

WARNING! Using controls, making adjustments, or performing procedures other 
than those specified in this user guide may result in exposure to 
hazardous radiation.

Canadian DOC Regulations
Complies with Canadian EMC Class B requirements. 

«Conforme à la classe B des normes canadiennes de compatibilité 
électromagnétiques «CEM».»

LED Safety
The infrared port on the front panel of this printer is classified as a 
Class 1 LED (Light Emitting Diode) device according to International 
Standard IEC 825-1 (EN 60825-1). This device is not considered 
harmful, but the following precautions are recommended.

! If the printer requires service, contact an authorized HP service 
center.

! Do not attempt to make any adjustments of the printer.

! Avoid direct eye exposure to the infrared LED beam.

! Be aware that the beam is invisible light and cannot be seen.

! Do not attempt to view the infrared LED beam with any type of 
optical device.
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VCCI Statement (Japan)

Korean EMI Statement

Laser Statement for Finland
LASERTURVALLISUUS

LUOKAN 1 LASERLAITE

KLASS 1 LASER APPARAT

HP LaserJet 2100 -laserkirjoitin on käyttäjän kannalta turvallinen 
luokan 1 laserlaite. Normaalissa käytössä kirjoittimen suojakotelointi 
estää lasersäteen pääsyn laitteen ulkopuolelle.

Laitteen turvallisuusluokka on määritetty standardin EN 60825-1 
(1993) mukaisesti.

VAROITUS!

Laitteen käyttäminen muulla kuin käyttöohjeessa mainitulla tavalla 
saattaa altistaa käyttäjän turvallisuusluokan 1 ylittävälle 
näkymättömälle lasersäteilylle.

VARNING!

Om apparaten används på annat sätt än i bruksanvisning 
specificerats, kan användaren utsättas för osynlig laserstrålning, som 
överskrider gränsen för laserklass 1.

HUOLTO

HP LaserJet  2100 -kirjoittimen sisällä ei ole käyttäjän huollettavissa 
olevia kohteita. Laitteen saa avata ja huoltaa ainoastaan sen 
huoltamiseen koulutettu henkilö. Tällaiseksi huoltotoimenpiteeksi ei 
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katsota väriainekasetin vaihtamista, paperiradan puhdistusta tai 
muita käyttäjän käsikirjassa lueteltuja, käyttäjän tehtäväksi 
tarkoitettuja ylläpitotoimia, jotka voidaan suorittaa ilman 
erikoistyökaluja.

VARO!

Mikäli kirjoittimen suojakotelo avataan, olet alttiina näkymättömälle 
lasersäteilylle laitteen ollessa toiminnassa. Älä katso säteeseen.

VARNING!

Om laserprinterns skyddshölje öppnas då apparaten är i funktion, 
utsättas användaren för osynlig laserstrålning. Betrakta ej strålen.

Tiedot laitteessa käytettävän laserdiodin säteilyominaisuuksista:

Aallonpituus 770-795 nm

Teho 5 mW

Luokan 3B laser
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B Media Specifications

Overview

This printer accepts a variety of media, such as cut-sheet paper 
(including up to 100% recycled fiber content paper), envelopes, 
labels, transparencies, and custom-size paper. Properties such as 
weight, composition, grain, and moisture content are important 
factors affecting printer performance and output quality. Paper that 
does not meet the guidelines outlined in this manual can cause the 
following problems:

! Poor print quality.

! Increased paper jams.

! Premature wear on the printer, requiring repair.

Note Some paper may meet all of the guidelines in this manual and still not 
produce satisfactory results. This might be the result of improper 
handling, unacceptable temperature and humidity levels, or other 
variables over which Hewlett-Packard has no control.

Before purchasing large quantities of paper, make sure the paper 
meets the requirements specified in this user guide and in the 
HP LaserJet Printer Family Paper Specification Guide. (For ordering 
information, see page 25). Always test paper before buying large 
quantities.

CAUTION Using paper that does not meet HP specifications may cause problems 
for the printer, requiring repair. This repair is not covered by the Hewlett-
Packard warranty or service agreements.
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Supported Sizes of Paper

Note You may experience some paper jams when using any media with a 
length less 178 mm (7 in.). This may be caused by paper that has been 
effected by environmental conditions. For optimum performance, make 
sure you are storing and handling the paper correctly. Please refer to 
“Printing and Paper Storage Environment” on page 144.

Tray 1 Dimensionsa Weight Capacityb

Minimum Size 
(custom)

76 by 127 mm
(3 by 5 in.) 60 to 163 g/m2 Bond

(16 to 43 lb)
100 sheets of 80 g/m2 
Bond (20 lb) paperMaximum Size 

(custom)
216 by 356 mm
(8.5 by 14 in.) 

Transparency

Same as minimum and 
maximum paper sizes 
listed above.

Thickness:
.10 to .14 mm 
(0.0039 to 0.0055 in.)

75 typical

Labelsc Thickness:
.10 to .14 mm
(0.0039 to 0.0055 in.)

50 typical

Envelopes Up to 90 g/m2 (16-24 lb) up to 10

a. The printer supports a wide range of media sizes. Check the printer software for supported sizes. See “Printing 
on Custom-Sized Media or Cardstock” on page 39.

b. Capacity may vary depending on media weight and thickness, and environmental conditions.
c. Smoothness - 100 to 250 (Sheffield).
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Tray 2 or Tray 3 Dimensionsa

a. The printer supports a wide range of media sizes. See “Printing on Custom-Sized Media or Cardstock” on 
page 39.

Weight Capacityb

b. Capacity may vary depending on media weight and thickness, and environmental conditions.

Letter 8.5 by 11 in.
(216 by 279 mm)

16 to 28 lb Bond

(60 to 105 g/m2)

250 sheets of 20 lb 

Bond (80 g/m2) paper

A4 210 by 297 mm
(8.3 by 11.7 in.)

Executive 7.3 by 10.5 in.
(191 by 267 mm)

Legal 8.5 by 14 in.
(216 by 356 mm)

B5 (ISO) 176 by 250 mm
(6.9 by 9.9 in.)

B5 (JIS) 182 by 257 mm
(7.2 by 10 in.)

A5 148 by 210 mm
(5.8 by 8.2 in.)

8.5 x 13 in. 216 by 330 mm
(8.5 by 13 in.)
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Guidelines for Using Paper

For best results, use conventional 90 g/m2 (24 lb) paper. Make sure 
the paper is of good quality, and free of cuts, nicks, tears, spots, loose 
particles, dust, wrinkles, voids, and curled or bent edges.

If you are unsure what type of paper you are loading (such as bond or 
recycled), check the label on the package of paper.

The following problems with paper cause print quality deviations, 
jamming, or even damage to the printer.

Symptom Problem with Paper Solution

Poor print quality or toner 
adhesion
Problems with feeding

Too moist, too rough, too 
smooth, or embossed; 
faulty paper lot

Try another kind of paper, 
between 100-250 Sheffield, 
4-6% moisture content

Dropouts, jamming, curl Stored improperly Store paper flat in its moisture-
proof wrapping

Increased gray background 
shading/printer wear

Too heavy Use lighter paper, open the rear 
output bin

Excessive curl
problems with feeding

Too moist, wrong grain 
direction or short-grain 
construction

Open the rear output bin
Use long-grain paper

Jamming, damage to printer Cutouts or perforations Do not use paper with cutouts 
or perforations

Problems with feeding Ragged edges Use good quality paper
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Note Do not use letterhead paper that is printed with low-temperature inks, 
such as those used in some types of thermography.

Do not use raised or embossed letterhead.

The printer uses heat and pressure to fuse toner to the paper. Make 
sure that any colored paper or preprinted forms use inks that are 
compatible with this fusing temperature (200° C or 392° F for 
0.1 second).

Paper Specifications

For complete paper specifications for all HP LaserJet printers, see the 
HP LaserJet Printer Family Paper Specification Guide.

Category Specifications

Acid Content 5.5 pH to 8.0 pH

Caliper .094-.18 mm (3.0-7.0 mils)

Curl in Ream Flat within 5 mm (.02 in.)

Cut Edge Conditions Cut with sharp blades with no visible fray.

Fusing Compatibility Must not scorch, melt, offset, or release 
hazardous emissions when heated to 
200° C (392° F) for .1 second.

Grain Long Grain

Moisture Content 4% to 6% by weight

Smoothness 100-250 Sheffield
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Printing and Paper Storage Environment

Ideally, the printing and paper storage environment should be at or 
near room temperature, and not too dry or too humid. Remember 
paper is hygroscopic; it absorbs and loses moisture rapidly.

Heat works with humidity to damage paper. Heat causes the moisture 
in paper to evaporate, while cold causes it to condense on the sheets. 
Heating systems and air conditioners remove most of the humidity 
from a room. As paper is opened and used, it loses moisture, causing 
streaks and smudging. Humid weather or water coolers can cause 
the humidity to increase in a room. As paper is opened and used it 
absorbs any excess moisture, causing light print and dropouts. Also, 
as paper loses and gains moisture it can distort. This can cause 
paper jams.

As a result, paper storage and handling are as important as the 
paper-making process itself. Paper storage environmental conditions 
directly affect the feed operation.

Care should be taken not to purchase more paper than can be easily 
used in a short time (about 3 months). Paper stored for long periods 
may experience heat and moisture extremes, which can cause 
damage. Planning is important to prevent damage to a large supply of 
paper.

Unopened paper in sealed reams can remain stable for several 
months before use. Opened packages of paper have more potential 
for environmental damage, especially if they are not wrapped with a 
moisture-proof barrier.

The paper storage environment should be properly maintained to 
ensure optimum printer performance. The required condition is 20° to 
24° C (68° to 75° F), with a relative humidity of 45% to 55%. The 
following guidelines should be helpful when evaluating the paper's 
storage environment:

! Paper should be stored at or near room temperature.

! The air should not be too dry or too humid (due to the 
hygroscopic properties of paper).

! The best way to store an opened ream of paper is to rewrap it 
tightly in its moisture-proof wrapping. If the printer environment is 
subject to extremes, unwrap only the amount of paper to be used 
during the day's operation to prevent unwanted moisture 
changes.
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Envelopes

Envelope construction is critical. Envelope fold lines can vary 
considerably, not only between manufacturers, but also within a box 
from the same manufacturer. Successful printing on envelopes 
depends upon the quality of the envelopes. When selecting 
envelopes, consider the following components:

! Weight: The weight of the envelope paper should not exceed 

105 g/m2 (24 lb) or jamming may occur. 

! Construction: Prior to printing, envelopes should lie flat with less 
than 6 mm (0.25 in.) curl, and should not contain air.

! Condition: Envelopes should not be wrinkled, nicked, or 
otherwise damaged. 

! Temperature: You should use envelopes that are compatible with 
the heat and pressure of the printer.

! Size: You should use only envelopes within the following size 
ranges.

Note Use only Tray 1 to print envelopes.

You may experience some paper jams when using any media with a 
length less 178 mm (7 in.). This may be caused by paper that has been 
effected by environmental conditions. For optimum performance, make 
sure you are storing and handling the paper correctly. Please refer to 
“Printing and Paper Storage Environment” on page 144. 

Minimum Maximum

Tray 1 76 by 127 mm
(3 by 5 in.)

216 by 356 mm
(8.5 by 14 in.)
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Envelopes with Double Side Seams
Double side-seam construction has vertical seams at both ends of the 
envelope rather than diagonal seams. This style may be more likely to 
wrinkle. Be sure the seam extends all the way to the corner of the 
envelope as illustrated below.

Envelopes with Adhesive Strips or Flaps
Envelopes with a peel-off adhesive strip or with more than one flap 
that folds over to seal must use adhesives compatible with the heat 
and pressure in the printer. The extra flaps and strips might cause 
wrinkling, creasing, or even jams and may even damage the fuser.

Correct

Incorrect
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Envelope Margins
The following gives typical address margins for a commercial #10 or 
DL envelope.

Note For the best print quality, position margins no closer than 15 mm 
(0.6 in.) from the edges of the envelope.

Avoid printing over the area where the envelope’s seams meet.

Envelope Storage
Proper storage of envelopes helps contribute to print quality. 
Envelopes should be stored flat. If air is trapped in an envelope, 
creating an air bubble, then the envelope may wrinkle during printing. 

See “Printing on Envelopes” on page 35.

Type of Address Top Margin Left Margin

Return address 15 mm (0.6 in.) 15 mm (0.6 in.)

Delivery address 51 mm (2 in.) 89 mm (3.5 in.)
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Labels

CAUTION To avoid damaging the printer, use only labels recommended for laser 
printers, such as HP-brand labels. (For ordering information, see page 
25.)

To prevent serious jams, always use Tray 1 to print labels and always 
use the rear output bin.

Never print on the same sheet of labels more than once or print on a 
partial sheet of labels.

Label Construction
When selecting labels, consider the quality of each component:

! Adhesives: The adhesive material should be stable at 200° C 
(392° F), the printer’s fusing temperature.

! Arrangement: Only use labels with no exposed backing between 
them. Labels can peel off sheets with spaces between the labels, 
causing serious jams.

! Curl: Prior to printing, labels must lie flat with no more than 
13 mm (.5 in.) of curl in any direction. 

! Condition: Do not use labels with wrinkles, bubbles, or other 
indications of separation. 

See “Printing on Labels” on page 37.
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Transparencies

Transparencies used in the printer must be able to withstand 200° C 
(392° F), the printer’s fusing temperature.

CAUTION To avoid damaging the printer, use only transparencies recommended 
for use in laser printers, such as HP-brand transparencies. (For 
ordering information, see page 25.)

See “Printing on Transparencies” on page 38.
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C Printer Memory and 
Expansion

Overview

! Printer Memory

! Installing Memory

! Checking Memory Installation

! Installing an HP JetDirect EIO Card
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Printer Memory

The printer has three dual in-line memory module (DIMM) slots for 
upgrading with:

! More printer memory. DIMMs are available in 4, 8, and 16 MB, for 
a maximum of 52 MB. 

! DIMM-based accessory fonts, macros, and patterns.

! Other DIMM-based printer languages and printer options.

See “Accessories and Ordering Information” on page 23.

Note Single in-line memory modules (SIMMs) used on previous HP LaserJet 
printers are not compatible with the printer.

You may want to add more memory to the printer if you often print 
complex graphics or PS documents, or use many downloaded fonts. 
To find out how much memory is installed in the printer, print a 
configuration page by pressing GO and JOB CANCEL while the printer 
is in the Ready state.
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Installing Memory  

CAUTION
Static electricity can damage dual in-line 
memory modules (DIMMs). When 
handling DIMMs, either wear an 
antistatic wrist strap or frequently touch 
the surface of the DIMMs’ antistatic 
package, then touch bare metal on the 
printer.

If you have not already done so, print a 
configuration page to find out how much 
memory is installed in the printer before 
adding more memory.

1 After the configuration page is 
printed, turn the printer off and 
disconnect the power cord. 

2 Open the interface cable door by 
pressing on the release tabs. 
Disconnect all interface cables.

3 Open the top cover.

4 Press the release button and slide 
the right side panel forward until the 
alignment arrows line up.

5 Pull the panel away from the printer, 
exposing the available DIMM slots.

Continued on next page

1

2

3

4

5
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6 Remove the DIMM from the 
antistatic package. 

7 Holding the DIMM by the edges, 
align the notches on the DIMM with 
the DIMM slot. (Check that the 
locks on each side of the DIMM slot 
are open.)

Note
For best results use DIMM Slots in 1-2-3 
order.

8 Press the DIMM straight into the 
slot (press firmly). Make sure the 
locks on each side of the DIMM 
snap inward into place. (To remove 
a DIMM, the locks must be 
released.) 

Repeat steps 6, 7, and 8 for each 
DIMM being installed.

9 To replace the side panel, line up 
the alignment arrows and slide the 
panel backwards until the release 
button latches into place. Close the 
top cover.

10 Reinstall the interface cable(s) and 
power cord. Turn the printer on.

7

8

6

9

10
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Checking Memory Installation

To verify that DIMMs are installed correctly:

1. Turn the printer on. Check that the printer control panel displays 
the Ready light after the printer has gone through the startup 
sequence. If an error message appears, a DIMM may have been 
incorrectly installed. See “Troubleshooting Error Messages” on 
page 99.

2. Print a configuration page by pressing the Go and Job Cancel 
buttons simultaneously.

3. Check the memory section on the configuration page and 
compare it with the configuration page printed before the DIMM 
installation. 

If the amount of recognized memory has not increased:

l The DIMM may not be installed correctly (repeat the installation 
procedure). 

l Try another DIMM Slot.

l The DIMM may be defective (try a new DIMM).

Note If you installed a printer language (personality), check the Installed 
Personalities and Options section on the configuration page. This area 
should list the new printer language.
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Installing an HP JetDirect EIO Card

1 Turn the printer off, and disconnect 
the power cord. 

2 Open the interface cable door by 
pressing on the release tabs. 
Disconnect all interface cables.

3 Locate the EIO Slot. Firmly insert 
the HP JetDirect EIO card into the 
EIO slot. Twist in the retaining 
screws.

4 Attach the appropriate network 
cable to the EIO card.

5 Reinstall the interface cable(s) 
power cord. Reinstall the interface 
cable door. Turn the printer on.

Note
Print a PCL configuration page to check 
that the HP JetDirect EIO card appears 
as an installed option.

4

1

2

3

5

4
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D Printer 
Commands

Overview

Most software applications do not require you to enter printer 
commands. See your computer and software documentation to find 
the method for entering printer commands, if needed. 

PCL

PCL printer commands tell the printer which tasks to perform or which 
fonts to use. This appendix provides a quick reference for users who 
are already familiar with PCL command structure.

The PCL 5e printer commands are backward-compatible with 
previous versions of PCL.

The PCL 6 printer commands take full advantage of the printer’s 
features.

HP-GL/2

The printer has the ability to print vector graphics using the HP-GL/2 
graphics language. Printing in the HP-GL/2 language requires that 
the printer leave PCL language and enter HP-GL/2 mode, which can 
be done by sending the proper PCL codes. Some software 
applications switch languages through their drivers.
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PJL

HP's Printer Job Language (PJL) provides control above PCL and 
other printer languages. The four major functions provided by PJL 
are: 

! printer language switching

! job separation

! printer configuration

! status readback from the printer

PJL commands may be used to change printer default settings

Note The table at the end of this appendix contains commonly used PCL 5e 
commands. For a complete listing and explanation of how to use PCL, 
HP-GL/2, and PJL commands, order the PCL/PJL Technical Reference 
Documentation Package. See “Supplementary Documentation” on 
page 25.

To receive more information about printer commands via fax, call 
HP FIRST (Fax Information Retrieval Service Technology) and request 
an index for HP LaserJet printers. (See the HP Support pages at the 
front of this user guide.)

Understanding PCL Printer Command Syntax
Before using printer commands, compare these characters: 

Lowercase l: l Uppercase O: O

Number one: 1 Number 0: 0
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Many printer commands use the lowercase letter l (l) and the number 
one (1), or the uppercase letter O (O) and the number zero (0). These 
characters may not appear on your screen as shown here. You must 
use the exact character and case specified for PCL printer 
commands.

The following illustration displays the elements of a typical printer 
command (in this instance, a command for page orientation).

Escape character 
(begins escape sequence)

Value field (contains both 
alpha and numeric characters)

Category of command
Uppercase letter 

(terminates escape sequence)
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Combining Escape Sequences
Escape sequences may be combined into one escape sequence 
string. There are three important rules to follow when combining 
code:

1. For each escape sequence, the first two characters after the ? 
character must be the same.

2. When combining escape sequences, change the uppercase 
(termination) character in each individual escape sequence to 
lowercase.

3. The final character of the combined escape sequence must be 
uppercase.

The following escape sequence string would be sent to the printer to 
select legal paper, landscape orientation, and 8 lines per inch:

?&l3A?&l1O?&l8D

The following escape sequence sends the same printer commands 
by combining them into a shorter sequence:

?&l3a1o8D

Entering Escape Characters
Printer commands always begin with the escape character (?). 

The following table shows how the escape character can be entered 
from various DOS software applications. 

DOS Software 
Application Entry What Appears

Lotus 1-2-3 Type \027 027

WordPerfect for DOS Type <27> <27>

MS-DOS Edit Hold down Ctrl-P, and press Esc ¨

MS-DOS Edlin Hold down Ctrl-V, release, then press [ ^[
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. 
Selecting PCL Fonts
PCL printer commands for selecting fonts can be found on the PCL 
Font List. A sample section is shown below. Notice the two variable 
boxes for symbol set and point size:

These variables must be filled in or the printer will use defaults. For 
example, if you want a symbol set that contains line-draw characters, 
select the 10U (PC-8) or 12U (PC-850) symbol set. Other common 
symbol set codes are listed in the table on page 161.

Note Fonts are either “fixed” or “proportional” in spacing. The printer contains 
both fixed fonts (Courier, Letter Gothic, and Lineprinter) and 
proportional fonts (CG Times, Arial, Times New Roman, and others)

Fixed-spaced fonts are generally used in applications such as 
spreadsheets and databases, where it is important for columns to line 
up vertically. Proportional-spaced fonts are generally used in text and 
word processing applications.

 

Common PCL Printer Commands

Function Command Options (#)

Job Control Commands

Reset ?E n/a

Number of Copies ?&l #X 1 to 999
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Page Control Commands

Paper Source ?&l #H 0 = prints or ejects current page
1 = Tray 2
2 = manual feed, paper
3 = manual feed, envelope
4 = Tray 1
5 = Tray 3
7 = auto select

Paper Size ?&l #A 1 = Executive
2 = Letter
3 = Legal
4 = A5
5 = A4
6 = B5-JIS
8 = 8.5 X 13
9 = B5 (ISO)
71 = Postcard (single size)
72 = Postcard (round trip)
80 = Monarch
81 = Commercial 10
90 = DL
91 = International C5
100 = B5
101 = Custom

Orientation ?&l #O 0 = Portrait
1 = Landscape
2 = Reverse Portrait
3 = Reverse Landscape

Top Margin ?&l #E # = number of lines

Text Length (bottom margin) ?&l #F # = number of lines from top margin

Left Margin ?&a #L # = column number

Right Margin ?&a #M # = column number from left margin

Horizontal Motion Index ?&k#H 1/120-inch increments (compresses print horizontally)

Common PCL Printer Commands (continued)

Function Command Options (#)
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Vertical Motion Index ?&l #C 1/48-inch increments (compresses print vertically)

Line Spacing ?&l #D # = lines per inch (1, 2, 3, 4, 5, 6, 12, 16, 24, 48)

Perforation Skip ?&l #L 0 = disable
1 = enable

Cursor Positioning

Vertical Position (Rows) ?&a#R # = row number

Vertical Position (Dots) ?*p#Y # = dot number (300 dots = 1 inch)

Vertical Position (Decipoints) ?&a#V # = decipoint number (720 decipoints = 1 inch)

Horizontal Position 
(Columns)

?&a#C # = column number

Horizontal Position (Dots) ?*p#X # = dot number (300 dots = 1 inch)

Horizontal Position 
(Decipoints)

?&a#H # = decipoint number (720 decipoints = 1 inch)

Programming Hints

End of Line Wrap ?&s#C 0 = Enable
1 = Disable

Display Functions On ?Y n/a

Display Functions Off ?Z n/a

Common PCL Printer Commands (continued)

Function Command Options (#)
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Language Selection

Enter PCL Mode ?%#A 0 = Use previous PCL cursor position
1 = Use current HP-GL/2 pen position

Enter HP-GL/2 Mode ?%#B 0 = Use previous HP-GL/2 pen position
1 = Use current PCL cursor position

Font Selection

Symbol Sets ?(# 8U = HP Roman-8 Symbol Set
10U = IBM Layout (PC-8) (code page 437) Default 
Symbol Set
12U = IBM Layout for Europe (PC-850) (code page 
850)
8M = Math-8
19U = Windows 3.1 Latin 1
9E = Windows 3.1 Latin 2 (commonly used in Eastern 
Europe)
5T = Windows 3.1 Latin 5 (commonly used in Turkey)
579L = Wingdings Font

Primary Spacing ?(s#P 0 = fixed
1 = proportional

Primary Pitch ?(s#H # = characters/inch

Set Pitch Modea ?&k#S 0 = 10
4 = 12 (elite)
2 = 16.5 - 16.7 (compressed)

Primary Height ?(s#V # = points

Primary Style ?(s#S 0 = upright (solid)
1 = italic
4 = condensed
5 = condensed italic

Common PCL Printer Commands (continued)

Function Command Options (#)
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Primary Stroke Wt. ?(s#B 0 = medium (book or text)
1 = semi bold
3 = bold
4 = extra bold

Typefacea ?(s#T Print a PCL font list to view the command for each 
internal font.

a. The preferred method is to use the primary pitch command.

Common PCL Printer Commands (continued)

Function Command Options (#)
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Index
Numerics
2-sided printing 40
3x5 cards

printing 39

A
accessing the printer driver 

44
accessories 23

ordering 23–25
acoustic emissions 130
additional drivers, 

obtaining 4

B
background shading on 

page 94
basics, printer 1–22
buttons 15
buying paper 28

C
canceling a print job 43
cardstock 39
characters improperly 

formed 95
checking memory 

installation 155
choosing driver 6
cleaners

using on printer 73
cleaning

engine 73
exterior 73
starting the cleaning 

process 74
toner cartridge 73

cleaning process 84
clearing paper jams 85
commands, printer 157–

165
escape sequences 160
selecting PCL fonts 161
syntax 158–160

compact disc 4
configuration page 84
control panel 15

buttons 15

light patterns 16
locking 11
troubleshooting 99

custom sized paper 39

D
deleting fonts 7
demo page 84
diagnostics, printer 7
DIMM

checking installed 
memory 155

ordering 23
upgrading 152

documentation, 
supplementary
ordering 25

DOS Remote Control 
Panel
accessing 12

drivers
OEM setup, See 

Readme on installation 
disk.

setup 7
drivers, printer

help software 6
selecting 6
switching languages 6

dropouts 93
duplex printing 40

E
energy savings 3
engine cleaning 73
envelopes

orientation 35
printing on 35
specifications 145

error messages 99
escape sequences 160

F
font list 84
fonts

deleting 7
installing 7

fonts, selecting PCL 161

FontSmart
installing 7
managing fonts 7

form feed
light message 17

G
Go button 15
graphics, vector 157

H
help

online 6
printer driver 6
software 6

Help button, in printer 
driver 6

help screens 6
HP FontSmart

installing 7
managing fonts 7

HP JetAdmin 7
HP JetSend

installing 9
HP LaserJet Utility

for Macintosh 11
HP Printer Job Language 

158
HP worldwide sales and 

service offices 124
HP-GL/2 commands 157
HP-UX 7

I
image defect examples 92
image defects

background shading on 
page 94

dropouts 93
improperly formed 

characters 95
repetitive defects 

(vertical) 95
toner smearing on page 

94
vertical lines on page 94
wavy characters 95

index cards
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printing on 39
infrared port

printing with 21
installing

fonts 7
FontSmart 7
JetSend 9

installing printer memory 
153–155

internal cleaning procedure 
75

J
JetAdmin

networks compatible with 
7

JetSend
installing 9

Job Cancel button 15

L
label

orientation 37
labels

specifications 148
language switching 3
languages

switching 6
Laser Writer driver 11
LaserJet Utility 11
latest drivers, obtaining 4
legal paper

loading in Tray 2 33
letterhead

printing on 42
light locations 15
locking control panel 11

M
Macintosh

printer drivers 11
printing errors 111
selecting alternate PPD 

113
software for 11
troubleshooting 110

maintenance
printer 69

media accessories
ordering 24

media input options 29
media sizes

Tray 1 29
Tray 2 30

memory

checking installation 155
expanding 153–155
installing 153–155
ordering 23
upgrading printer’s 152

memory features 3
MS Windows 3.1, 95, or NT

help 6
network software 7
software 7

N
network administrator 

software 7
network issues

troubleshooting 107
Novell Netware 7
N-up printing 50

O
online help 6
overhead transparencies

specifications 149

P
paper 139

3-hole punch orientation 
42

3x5 cards 39
custom sized 39
guidelines 142
postcards 39
purchasing 28
size specifications 140

paper handling 
accessories
ordering 24

paper handling features 2
paper jam

areas 85
causes 85
output areas 89
toner cartridge area 86
Tray 2 paper feed area 

88
paper selection

default 29
paper sizes

loading in Tray 2 33
maximum 29
minimum 29

paper width guide
Tray 1 31

part numbers 23
PCL

commands 157–165
selecting fonts 161
syntax 158–160

PCL 5e drivers
function 6

PCL 6 drivers
function 6

PCL language features 2
PJL commands 158
postcards

printing 39
PPDs

Macintosh 11
selecting alternate 113

print defects
vertical on page 95

print quality features 2
print quality problems 91
print speed 2
printer

accessories 23
basics 1–22
checking installed 

memory 155
cleaning 73
commands 157–165
diagnostics 7
drivers 6
drivers, Macintosh 11
help software 6
installing memory 153–

155
maintenance 69
memory 153
redistributing toner 71
renaming 113
repacking 118
selecting drivers 6
service 117
software 4
syntax for commands 

158–160
upgrading memory 152

printer drivers
accessing 44
help software 6
software 7
windows 6

printer features 2
Printer Page Description 

Files, see PPDs
printer settings

changing in DOS from 
RCP 12

printing
canceling print job 43
168    Index EN

Download from Www.Somanuals.com. All Manuals Search And Download.



double sided 40
duplexing 40
envelopes 35
forms 42
labels 37
letterhead 42
multiple pages on one 

sheet 50
postcards 39
preparing for 28
quality guidelines 142
stopping print job 43
transparencies 38
with low toner 71

printing languages 6
printing problems

troubleshooting 80
problem solving checklist 

78
Product Stewardship 132–

134
memory expansion 153–

155
paper

recycled paper 139
specifications 143

product return 117
warranty

standard 121–122
PS drivers

function 6
purchasing paper 28

Q
quality, printer

toner cartridge 71
quality, printing

guidelines for 142

R
redistributing toner 71
Remote Control Panel

accessing 12
renaming the printer 113
repacking the printer 118

S
sales and service offices 

124
selecting

alternate PPD 113
self-test page, see 

configuration page
service agreements 120
Setup

driver only 7
software

drivers 7
help for drivers 6
HP FontSmart, installing 

7
HP JetSend, installing 9
HP LaserJet Utility for 

Macintosh 11
included with printer 4
Macintosh 11
Macintosh printer drivers 

11
Windows 6, 7

Solaris 7
special pages

cleaning process 84
configuration page 84
demo page 84
font list 84

specifications
envelopes 145
labels 148
paper size 140
transparencies 149

Status Messages
Attention 18
Continuable Error 19
Data 17
Fatal Error 19
Manual Feed with Pause 

17
Paper out 18
Paper out (requested 

tray) 18
processing 17
Ready 16
Startup 16

stopping a print job 43
Sun OS 7
supplementary 

documentation
ordering 25

supplies
ordering 23–25

support 117
switching printer languages 

6

T
toner cartridge 70

cleaning 73
ordering 23
recycling 70
warranty 123

toner cleaning 73

toner smearing on page 94
transfer roller 73
transparencies

printing on 38
specifications 149

Tray 1
capacity 31
loading 31
media sizes 29
media types 29
opening 31
paper sizes 140

Tray 2
changing paper sizes 33
media sizes 30
paper sizes 140

tray, optional
paper sizes 140

troubleshooting
control panel lights 99
error messages 99
general printing 

problems 80
Macintosh printing 

problems 110
PS problems 114

troubleshooting checklist 
78

TrueType fonts 7

U
UNIX, see HP-UX

V
vector graphics 157
vertical lines on page 94

W
warranty

toner cartridge 123
wavy characters 95
Windows

help 6
network software 7
software 7

wireless printing
background information 

20
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